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Epson Stylus Photo R270 User’s Guide

This User’s Guide contains instructions on printing with Windows® or Macintosh,® 
maintaining the Epson Stylus® Photo R270, solving basic problems, and 
specifications. To set up your printer and install your software, see the Start Here 
sheet.

Please follow these guidelines throughout:

Warnings must be followed carefully to avoid bodily injury.

Cautions must be observed to avoid damage to your equipment.

Notes contain important information about your printer.

Tips contain additional hints for better printing.
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About Your Printer

Your Epson Stylus Photo R270 is a full-featured printer. With its exceptional speed 
and print resolutions, you can print superior photographs and use it for all of your 
everyday printing, plus print directly onto CDs and DVDs. It provides you with these 
advanced features:

■ Hi-Definition Photographic inks, for smudge-, scratch-, water-, and fade-resistant 
photos

■ Automatic photo correction when printing from Windows

■ Smooth gradations and sharp detail with Epson’s patented MicroPiezo® print 
head and DX5 technology

■ CD and DVD printing on ink jet-printable CDs and DVDs

■ True BorderFree® frame-ready prints on select 4 × 6 (10,2 × 15,2 cm), 5 × 7 (12,7 
× 17,8 cm), 8 × 10 (20,3 × 25,4 cm), and letter-size (21,6 × 27,9 cm) papers

■ PictBridge™ printing directly from your digital camera or mobile phone

About Exif Print

The Exif (Exchangeable Image File) Print format includes information about your 
digital camera settings in JPEG/TIFF files so your printer and application can use 
them to create accurate print settings. Most digital cameras store Exif Print 
information such as shutter speed, metering, flash, exposure settings, resolution, and 
lens use in the JPEG/TIFF image file. Your printer uses the information to ensure the 
most accurate image reproduction.
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About Your Software

The CD-ROM that came with your printer includes all the software you need for 
printing. See your Start Here sheet for installation instructions.

■ Your printer driver runs your printer and lets you control how your documents 
look. You can’t print without it.

It’s a good idea to check Epson’s periodically for free updates to your printing 
software. Click the Driver Update button on the Maintenance tab in your Windows 
printer software or visit Epson’s support website. Download instructions are posted 
for your convenience. 

Tip: It’s a good idea to check Epson’s support website periodically for free 
updates to your Epson Stylus Photo R270 Series printer software. Download 
instructions are posted for your convenience. With Windows, you can also click 
Start or [Windows Vista "Start" icon], select Programs or All Programs, select 
EPSON, and click EPSON Stylus Photo R270 Series Driver Update for printer 
driver updates.

■ Epson Print CD lets you design CD or DVD labels and print them on CDs or 
DVDs using your Epson Stylus Photo R270.

■ ArcSoft PhotoImpression™ lets you edit, retouch, or enhance images and print 
them with templates, frames, and borders. See the PhotoImpression Help utility 
for instructions on using the program (available only available for Macintosh 
users).

■ Paint Shop™ Photo Album™ is simply the easiest way to do more with your 
digital photos. Now you can organize, fix, share, and protect photos with one 
easy-to-use tool (available only for Windows users).

■ Epson PhotoCenterSM is Epson’s free photo-sharing web site where you can store, 
organize, and share your photos; print high-resolution photos straight from the 
web; and create free online postcards with your photos. Your printer software 
installer lets you add a link to the Epson PhotoCenter on your desktop.

http://www.latin.epson.com
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■ Epson CreativeZoneSM is Epson’s free photo project web site where you can 
combine your favorite photos, Epson papers, and your printer to create 
unforgettable personalized craft projects. Your printer software installer lets you 
add a link to the Epson CreativeZone on your desktop.

■ Epson Web-To-Page™ automatically adjusts web pages to fit your printed page. 
No more cut-off edges! All you have to do is select Print on the Web-To-Page 
toolbar in Internet Explorer. (Requires Windows with Internet Explorer 5.5 or 
later.)
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Printer Parts

Paper support

Sheet feeder Printer cover

Front tray

Front tray extensions

Tray lever

EXT. I/F USB port

Left edge guide

Right edge guide

Front cover
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USB port

Cartridge cover

Ink button

Paper buttonPower button
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Loading Paper

■ Single Sheets

■ Envelopes

■ Special Papers

Single Sheets

1. Open the paper support and slide out its extension.

2. Open the front cover, then slide out the front tray extensions.
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Make sure the front tray is in the paper (lower) position. If it is not, push the tray 
lever up to reposition the front tray.

Caution: Before you move the tray lever, make sure no paper or other objects are 
on the front tray and the front tray is not extended.

Do not touch the front tray when you move the tray lever.

Do not move the tray lever while the printer is printing.

Note: If the tray is in the CD/DVD (upper) position when you turn the printer on, 
the error lights on the printer will flash. Move the tray to the lower position to 
clear the error.

3. Slide the left edge guide to the left.
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4. Insert the paper, printable side up, against the right edge guide and behind the 
tab.
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Insert the paper 
against the right 
edge guide and 
behind this tab.

8 × 10-in. (20,3 × 25,4 cm) or 
Letter-size (21,6 × 27,9 cm) 
paper

Insert the paper 
against the right 
edge guide and 
behind this tab.

4 × 6-in. (10,2 × 15,2 cm) or 
5 × 7-in. (12,7 × 17,8 cm) 
paper
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You can load up to 120 sheets of plain paper and up to 20 sheets of photo paper. 
(See Special Papers for capacity guidelines on other paper types.)

Note: The type of paper you choose affects the way your printout looks, so be 
sure to select the correct paper for your job. If you are just printing a rough draft 
of an image, plain paper is fine. However, for the best results, you’ll want to use 
one of Epson’s special ink jet papers designed for your printer. For example, your 
photos will look great printed on Epson Ultra Premium Photo Paper Glossy. See 
Special Papers for more information.

If you’re inserting a stack of paper, fan the stack and then tap it on a flat surface 
to even the edges before you insert it.



16

5. Slide the left edge guide against the left edge of the paper (but not too tightly).

Follow these guidelines when loading paper:

■ Leave enough space in front of the printer for the paper to be fully ejected.

■ Don’t load paper above the arrow on the left edge guide. Make sure the paper is 
under the tabs on the left and right edge guides.

8 × 10-in. (20,3 × 25,4 cm) or 
Letter-size (21,6 × 27,9 cm) 
paper

4 × 6-in. (10,2 × 15,2 cm) or 5 × 
7-in. (12,7 × 17,8 cm) paper
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■ Load the printable side face-up. It’s often brighter or whiter than the other side.

■ Always load the short edge first, even when printing in landscape mode.

■ Load letterhead or preprinted paper into the printer top edge first.

■ If you experience paper feeding problems, try loading fewer sheets.

■ If you’re using special paper, follow the instructions that came with it.

Envelopes

1. Open the paper support and slide out its extension.
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2. Open the front cover, then slide out the front tray extensions.

Make sure the front tray is in the paper (lower) position. Follow the instructions if 
you need to reposition the front tray.

3. Slide the left edge guide to the left.
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4. Load up to 10 envelopes at a time, flap edge left, printable side up, against the 
right edge guide.

Note: You may need to press down on the envelopes to flatten them before 
loading. If print quality declines when a stack of envelopes is loaded, load one 
envelope at a time.

Do not use envelopes that are curled or folded.

Flatten the flaps and the leading edge of the envelope before loading.

Avoid using envelopes that are too thin, as they may curl during printing.

5. Slide the left edge guide against the envelopes (but not too tightly).

Select the following settings when printing on envelopes:

■ Envelope as the paper Type or Media Type setting

■ The correct envelope size as the Size or Paper Size setting

■ Landscape as the Orientation setting

For instructions on selecting these settings, see:

■ Printing in Windows

■ Printing with Macintosh OS X

Load the flap edge 
left, facing down
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Special Papers

You can achieve good results with most types of plain bond paper. Coated papers, 
however, provide superior printouts because they absorb less ink.

Epson® provides special papers that are formulated for the ink used in Epson ink jet 
printers, and recommends these papers to ensure high-quality results.

Note: When you use special paper, check the package for special instructions 
regarding the loading and use of the paper.

If the paper is curled, flatten it or curl it slightly in the opposite direction before 
loading. Printing on curled paper may cause ink to smear on your printout.

Return unused paper to its original package as soon as you finish printing. To 
keep your printouts looking their best, see Storing and Displaying Your Prints.

Caution: If your Epson special paper included a cleaning sheet, don’t use it with 
this printer. The cleaning function performed by the sheet is not necessary with 
the Epson Stylus Photo R270, and the sheet could jam.
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Epson offers the following special papers for the Epson Stylus Photo R270:

Paper name* Size Part number

Epson Ultra Premium Photo Paper Glossy

Epson Ultra Premium Glossy Photo Paper

Borderless 4 × 6 in. (10.2 
× 15.2 cm)

S041934

Letter (8.5 × 11 in.; 21.6 
× 27.9 cm)

S041935

Epson Premium Photo Paper Glossy

Epson Premium Glossy Photo Paper

Borderless 4 × 6 in. (10.2 
× 15.2 cm)

S041808

S041727

Borderless 5 × 7 in. (12.7 
× 17.7 cm)

S041464

Borderless 8 × 10 in. 
(20.3 × 25.4 cm)

S041465

Letter (8.5 × 11 in.; 21.6 
× 27.9 cm)

S041286

S041667

Epson Premium Photo Paper Semi-Gloss

Epson Premium SemiGloss Photo Paper

Borderless 4 × 6 in. (10.2 
× 15.2 cm)

S041982

Letter (8.5 × 11 in.; 21.6 
× 27.9 cm)

S041331

Epson Photo Paper Glossy

Epson Glossy Photo Paper

Borderless 4 × 6 in. (10.2 
× 15.2 cm)

S041134

S041809

S041809-20

Letter (8.5 × 11 in.; 21.6 
× 27.9 cm)

S041141

S041649

Epson Bright White Paper Letter (8.5 × 11 in.; 21.6 
× 27.9 cm)

S041586

Epson Premium Presentation Paper Matte

Epson Matte Paper Heavyweight

Borderless 8 × 10 in. 
(20.3 × 25.4 cm)

S041467

Letter (8.5 × 11 in.; 21.6 
× 27.9 cm)

S041257
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* The availability of paper types and sizes varies by location.

You can purchase genuine Epson ink and paper from an Epson authorized reseller. To 
find the nearest reseller, call your Epson sales office as described in Where to Get 
Help.

When loading Epson ink jet papers, follow these capacity guidelines:

Epson Premium Presentation Paper Matte 
Double-Sided

Epson Double-Sided Matte Paper

Letter (8.5 × 11 in.; 21.6 
× 27.9 cm)

S041568

Epson Presentation Paper Matte

Epson Photo Quality Ink Jet Paper

Letter (8.5 × 11 in.; 21.6 
× 27.9 cm)

S041062

Epson Iron-on Cool Peel Transfer paper Letter (8.5 × 11 in.; 21.6 
× 27.9 cm)

S041153

Epson Ultra Premium Photo Paper Luster

Epson Premium Luster Photo Paper

Letter (8.5 × 11 in.; 21.6 
× 27.9 cm)

S041405

Paper name Loading capacity

Epson Presentation Paper Matte

Epson Photo Quality Ink Jet Paper

100 sheets

Epson Bright White Paper
Epson Premium Bright White Paper

80 sheets

Paper name* Size Part number
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Printing in Windows

See these sections for instructions on selecting printer settings:

■ Printing from an Application

■ Selecting the Default Settings for All Windows Programs

■ Customizing Windows Print Settings

■ Printing a Web Page Using Epson Web-To-Page

■ Printing with Special Layout Options

■ Cancelling Printing

Epson Ultra Premium Photo Paper Glossy
Epson Ultra Premium Glossy Photo Paper

Epson Premium Photo Paper Glossy
Epson Premium Glossy Photo Paper

Epson Premium Photo Paper Semi-Gloss
Epson Premium Semi-Gloss Photo Paper

Epson Photo Paper Glossy
Epson Glossy Photo Paper

Epson Premium Presentation Paper Matte
Epson Matte Paper Heavyweight

Epson Premium Presentation Paper Matte Double-Sided
Epson Double-Sided Matte Paper

Epson Ultra Premium Photo Paper Luster
Epson Premium Luster Photo Paper

20 sheets

Epson Iron-on Cool Peel Transfer paper

Epson Photo Quality Self Adhesive Sheets

1 sheet

Paper name Loading capacity
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Printing from an Application

After you create a document in a software program, follow these steps to print it using 
the basic printer settings:

1. Open the File menu and select Print. You see a Print window like this one:

2. Make sure Epson Stylus Photo R270 Series is selected.

3. Click the Properties or Preferences button. (If you see a Setup, Printer, or 
Options button, click it. Then click Properties or Preferences on the next 
screen.)

Click here to 
open your printer 
software

Select your printer here
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4. On the Main tab, select the basic print settings:

Select from these Quality Option types:

■ Draft: For rough drafts with reduced print quality

■ Text: For text-only documents with higher text quality

■ Text & Image: For documents with text and images with higher quality

■ Photo: For photos and graphics with good quality and speed

■ Best Photo: For photos or graphics with high print quality

Note: For more information about printer settings, click the Help button or click 
the ? button and then click on the area you need help with.

The Quality Option settings on this screen give you the best combination of 
quality and speed for most prints. For the highest quality (Photo RPM®) on 
selected papers, click the Advanced button on the Main tab. Then see 
Customizing Windows Print Settings for instructions on selecting Photo RPM.

For more information about your printer, click the Online Support button and 
then select the Stylus Photo R270.

Select the type of document you’re printing

Select your 
paper Type

Select your 
paper Size

Select your 
document 
or image 
orientation

Select Sheet
Select 
PhotoEnhance™ to 
automatically 
correct photos
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5. Select Sheet as the source setting.

6. Make sure the paper Type and size settings match the paper you’ve loaded in the 
printer. 

7. Select other settings as shown above.

8. Click OK.

9. At the Print window, click OK or Print to start printing.

During printing, the following window appears and shows the progress of your print 
job. You can use the buttons to cancel, pause, or resume printing. You can also see 
how much ink you have left.

Selecting the Default Settings for All Windows 
Programs

When you change the printer settings within a program, they apply only to that 
program. If you want to change the default printer settings for all your programs, 
follow these steps:

1. Right-click the  printer icon in the lower right corner of your screen (taskbar).

Click to 
cancel 
printing

Click to pause 
or resume 
printing
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Note: If you don’t see the icon, see You don’t see the printer icon in the lower 
right corner of your screen (taskbar) in Windows.

2. Select Printer Settings.

3. Select the default settings you want for all your applications, then click OK.

You can still change the printer settings in your individual programs, when necessary. 
For any given program, the new settings will override the Windows default settings 
until the next time you close and reopen the program.

Customizing Windows Print Settings

You can use advanced settings for color matching, printing at a higher resolution, or 
selecting a variety of special effects and layouts.

1. On the Main tab, click the Advanced button in the bottom right corner of the 
window.

2. If you see a warning note, click Continue.

3. Select the following advanced settings as necessary:

Select a color 
management 
method

(To choose
No Color 
Adjustment, 
click ICM first)

Select Paper & Quality 
Options as necessary

Click here to select 
your quality option

Select Print Options 
as necessary
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Note: For the highest quality on selected papers, you can select Photo RPM 
(5760 × 1440) from the quality option pop-up menu (as shown above). When you 
select Photo RPM, printing will take longer.

For more information about advanced settings, or instructions on saving them as 
a group so you can reuse them later, click the ? button or click the Help button 
and then click on the area you need help with.

If you want to use the Advanced screen each time you access your printer 
settings, click Show this screen first.

4. Once you’ve finished selecting advanced settings, you can:

■ Click OK to save your settings, return to the Print window, and print.

■ Click the Basic button to return to the Basic settings.

■ Continue with step 5 to change the layout options.

5. Click the Page Layout tab and select the following page layout settings as 
necessary:

Note: For more information about page layout settings, click the Help button, 
click the ? button and then click on the area you need help with, or see Printing 
with Special Layout Options.

Select multi-page 
document options 
here and here

Select image resizing 
options here; these 
affect only your 
printed image

Select image 
position options 
here

Click here to add a 
watermark to your 
printed page
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6. Click OK to save your settings, then click OK or Print.

Printing a Web Page Using Epson Web-To-Page

The Epson Web-To-Page software lets you print web pages so that they fit within the 
width of your selected paper.

Note: Epson Web-To-Page is available for Windows only.

1. In Internet Explorer, go to the web page you want to print.

If you have installed Epson Web-To-Page, the Epson Web-To-Page toolbar 
appears at the top of the Internet Explorer window.

2. Click the Print button on the Epson Web-To-Page toolbar. The print window 
appears.

Note: If you want to preview the layout of your printout, click Print Preview on 
the toolbar.

3. Do one of the following:

■ Windows XP, Me, and 98SE: Make sure EPSON Stylus Photo R260 
Series is selected, then click the Properties or Preferences button. (If you 
see a Setup, Printer, or Options button, click it. Then click Properties or 
Preferences on the next screen.)

■ Windows 2000: Right-click the EPSON Stylus Photo R260 Series icon 
and choose Printing Preferences.

4. Select your preferences, then click OK.

5. At the Print window, click OK or Print to start printing.
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Printing with Special Layout Options

■ Printing Double-sided

■ Reducing or Enlarging Your Prints

■ Printing Multiple Photos or Pages Per Sheet

■ Printing Posters

■ Printing Watermarks

Printing Double-sided

Double-sided printing allows you to print the odd-numbered pages first. Once these 
pages are printed, you can reload them to print the even-numbered pages onto the 
opposite sides of the paper.
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Note: This feature is not available when you are printing borderless, and may not 
be available when the printer is being accessed over a network or used as a 
shared printer.

Depending on the paper and the amount of ink used to print text and images, ink 
may bleed through to the other side of the paper. The surface of the paper may 
be smeared during double-sided printing.

1. Open the File menu and select Print. You see a Print window like this one:

2. Make sure EPSON Stylus Photo R270 Series is selected.

3. Click the Properties or Preferences button. (If you see a Setup, Printer, or 
Options button, click it. Then click Properties or Preferences on the next 
screen.)

Click here to 
open your printer 
software

Select your printer here
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4. On the Main tab, select basic print settings as described in Printing from an 
Application, then click the Page Layout tab. You see a window like this one:

5. Click the Double-Sided Printing check box, then click Margins to open the 
Margins window.

6. Specify the edge of the paper where the binding will be placed. You can choose 
Left, Top, or Right.

7. Choose cm or inch as the Unit setting. Then specify the width of the binding 
margin. You can enter any width from 0.3 cm (0.12 inches) to 3.0 cm (1.18 
inches).

Click the 
Double-Sided 
Printing check box

Click here to open 
the Margins 
window
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Note: The actual binding margin may be different from the specified settings 
depending on your application. Experiment with a few sheets before printing the 
entire job.

8. Click OK to return to the Page Layout screen. Then click OK to close the printer 
settings window.

9. At the Print window, click OK or Print to start printing.

10. Follow the on-screen instructions to reload the paper.

Note: The paper may curl during printing due to the amount of ink used. Should 
this occur, slightly curl the sheets in the opposite direction before reloading them.

Align the sheet stack by tapping its edges against a hard, flat surface before 
reloading the stack.

Follow the instructions provided when reloading the printouts. Otherwise, paper 
may jam or the binding margins may be incorrect.

11. Once you’ve reloaded the paper, click Resume to print the even-numbered 
pages.

Reducing or Enlarging Your Prints

You can use this feature to print a large photo or image on 4 × 6 (10.2 × 15.2 cm) 
paper, for example.

You can automatically resize your page to the paper size you select or choose a 
percentage of enlargement or reduction.
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Note: This feature is not available when you are printing borderless.

1. Open the File menu and select Print. You see a Print window like this one:

2. Make sure that EPSON Stylus Photo R270 Series is selected.

3. Click the Properties or Preferences button. (If you see a Setup, Printer, or 
Options button, click it. Then click Properties or Preferences on the next 
screen.)

Click here to 
open your printer 
software

Select your printer here
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4. On the Main tab, select the basic print settings as described in Printing from an 
Application, then click the Page Layout tab. You see a window like this one:

5. Click the Reduce/Enlarge Document check box.

6. Do one of the following:

■ If you selected By Output Paper Size, select the size of the paper you are 
using from the drop-down list.

■ If you selected By Percentage, use the arrows to choose a percentage.

7. Click OK to close the printer settings window.

8. At the Print window, click OK or Print to start printing.

Note: It’s a good idea to print one test copy and examine the results before 
printing multiple copies.

Click the 
Reduce/Enlarge 
Document 
check box
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Printing Multiple Photos or Pages Per Sheet

Note: This feature is not available when you are printing borderless.

1. Open the File menu and select Print. You see a Print window like this one:

2. Make sure EPSON Stylus Photo R270 Series is selected.

3. Click the Properties or Preferences button. (If you see a Setup, Printer, or 
Options button, click it. Then click Properties or Preferences on the next 
screen.)

Click here to 
open your printer 
software

Select your printer here
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4. On the Main tab, select the basic print settings as described in Printing from an 
Application, then click the Page Layout tab. You see a window like this one:

5. Select Multi-Page, then select Pages Per Sheet.

6. Select from the following settings for Pages Per Sheet printing:

■ 2, 4: Prints two or four photos or pages on a single piece of paper.

■ Print Page Borders: Prints frames around the pages printed on each sheet.

■ Page Order: Allows you to specify the order in which the pages will be 
printed on the sheet of paper. Some settings may be unavailable, depending 
on the Orientation setting (on the Main tab).

7. Click OK to close the printer settings window.

8. At the Print window, click OK or Print to start printing.

Note: It’s a good idea to print one test page and examine the results before 
printing multiple pages.

Select Pages 
Per Sheet

Click the 
Multi-Page 
check box
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Printing Posters

You can print poster-size images by enlarging one image to cover several sheets of 
paper.

Printing the Poster Sections

1. Open the File menu and select Print. You see a Print window like this one:

2. Make sure EPSON Stylus Photo R270 Series is selected.

3. Click the Properties or Preferences button. (If you see a Setup, Printer, or 
Options button, click it. Then click Properties or Preferences on the next 
screen.)

Click here to 
open your printer 
software

Select your printer here
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4. On the Main tab, select the basic print settings as described in Printing from an 
Application, then click the Page Layout tab. You see a window like this one:

5. Select Multi-Page, then select Poster Printing.

6. Click the up or down arrow to select 2x1, 2x2, 3x3, or 4x4.

7. Select Borderless if you would like each of your sheets to have no margin.

Note: If you select Borderless, portions of your printout will be cropped on each 
sheet because this option enlarges your printout slightly beyond the paper size. 
You can use the Borderless Expansion slider (on the Page Layout tab) to control 
the amount of the image that extends beyond the edges of the paper.

The Borderless setting for poster printing is not available with Windows Me and 
98SE.

If you don’t select Borderless, your sheets will have margins and they will have 
to be cut and overlapped to form your poster. You will be able to align your sheets 
more precisely, however, since your printouts won’t be cropped.

Select Poster 
Printing

Click the 
Multi-Page 
check box
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8. Click Settings to adjust the way your poster will be printed. The Poster Settings 
window opens.

9. If you want to print only a few of the panels without printing the entire poster, 
click the panels that you do not want to print.

10. If you didn’t select Borderless, make the following settings:

■ Print Cutting Guides: Prints guide lines for cutting.

■ Overlapping Alignment Marks: Slightly overlaps the panels and prints 
alignment markers so that the panels can be aligned more precisely.

■ Trim Lines: Prints border lines on the panels to guide you when trimming 
the pages.

Note: If you selected Borderless, the settings listed above are not available.

11. Click OK to return to the Page Layout screen. Then click OK to close the printer 
settings window.

12. At the Print window, click OK or Print to start printing.
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Assembling the Poster

Follow these steps to create a poster from your printouts. The instructions are based 
on selecting 2x2 and Overlapping Alignment Marks as your cutting guide option:

1. Cut off the margin of sheet 1 along a vertical line through the center of the top 
and bottom cross marks.

2. Place the edge of sheet 1 on top of sheet 2 and align the cross marks, then 
temporarily tape the two sheets together from the back.
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3. Cut the taped sheets in two along a vertical line through the alignment marks (this 
time, a line to the left of the cross marks).

4. Align the edges of the paper using the alignment marks and tape them together 
from the back.

5. Repeat steps 1 to 4 to tape sheets 3 and 4 together.

6. Repeat steps 1 to 4 to tape the top and bottom sections together.
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7. Cut off the remaining margins.

Printing Watermarks

You can print text-based or image-based watermarks on your document.

Note: This feature is not available when you are printing borderless.

Printing Standard Watermarks

1. Open the File menu and select Print. You see a Print window like this one:

2. Make sure EPSON Stylus Photo R270 Series is selected.

3. Click the Properties or Preferences button. (If you see a Setup, Printer, or 
Options button, click it. Then click Properties or Preferences on the next 
screen.)

Click here to 
open your printer 
software

Select your printer here
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4. On the Main tab, select the basic print settings as described in Printing from an 
Application, then click the Page Layout tab. You see a window like this one:

5. Select the watermark you want to use, then click Settings.

Click here to 
select your 
watermark

Click here to open 
the Watermark 
window
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6. Specify settings for the watermark. You can change the position and size of the 
watermark by dragging the image within the preview window.

7. Click OK to return to the Page Layout screen. Then click OK to close the printer 
settings window.

8. At the Print window, click OK or Print to start printing.

Note: Print one test copy and examine the results before printing an entire job.

Adding Your Own Watermarks

You can also add your own text-based or image-based watermarks to the watermark 
list.

1. Click Add/Del under Watermark on the Page Layout screen. The following 
window appears.

2. Do one of the following:

■ To use an image file as a watermark, select BMP. Click Browse to locate the 
bitmap file you want to use, then click OK. Type a name for your watermark 
in the Name text box, then click Save.

■ To create a text-based watermark, select Text. Type the word or words in the 
Text box. This text will also be used as the watermark name. If you want to 
change the watermark name, type a new name in the Name box, then click 
Save.
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3. Click OK to return to the Page Layout screen.

4. Click Settings and select the settings for your watermark.

5. When you finish making settings, click OK.

Cancelling Printing

■ Using the Buttons on the Printer

■ Using Your Computer

Using the Buttons on the Printer

Press the paper button to cancel your print job from the printer.

Using Your Computer

When you start printing, the following window appears. Click the Stop button to 
cancel printing.

Click to cancel 
printing
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Using Epson Spool Manager in Windows 98SE or Me

If you’re using Windows 98SE or Me, you can also cancel a print job using the Epson 
Spool Manager.

When you send a print job, Epson Spool Manager will open on your screen.

To cancel printing, select the job in the list and click Cancel.

Note: If you have stalled print jobs, you can also delete those from Epson Spool 
Manager by selecting them and clicking Cancel. If you are having a problem with 
printing, deleting stalled print jobs may resolve the issue.

Printing with Macintosh OS X

See these sections for instructions on selecting printer settings:

■ Printing from an Application

■ Customizing Mac OS X Print Settings

■ Printing Multiple Photos or Pages Per Sheet
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Printing from an Application

After you create a document in a software program, follow these steps to print it using 
the basic printer settings:

1. Open the File menu and select Page Setup. You see the Page Setup window:

2. Select Stylus Photo R270 in the Format for pop-up menu.

3. Select your Paper Size. For borderless printing, select a paper size with the Sheet 
Feeder - Borderless option. See Printing Borderless Photos for details.

4. Select  portrait or  landscape as the orientation setting.

5. Click OK.

6. Open the File menu and select Print. You see a window like this one:

Select Stylus Photo R270

Select your Paper Size

Select your document 
or image orientation

Select Print 
Settings 

Select Stylus 
Photo R270
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7. Select Stylus Photo R270 in the Printer pop-up menu.

8. Select Print Settings from the pop-up menu.

9. Select the following Print Settings as necessary:

Note: For more information about printer settings, click the ? button.

The Quality setting on this screen gives you the best combination of quality and 
speed for most prints. For the highest print quality (Photo RPM) on selected 
papers, click Advanced and see Customizing Mac OS X Print Settings.

The automatic photo correction feature is not available with Mac OS X.

10. Depending on your settings, you can choose other options from the pop-up 
menu:

■ Copies & Pages: Select the number of copies you want or a page range.

■ Layout: Select page layout options.

■ Scheduler: Schedule your print job to print at a later time.

■ Paper Handling: Select page printing options, such as Reverse print order.

Select your 
Media Type

Select Color 
or Grayscale

Select higher 
quality or 
faster printing 
(if available)

Click Print
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■ ColorSync or Color Management: Select ColorSync® or adjust the color 
controls or gamma setting, or turn off color adjustments in the printer 
software.

■ Expansion: Reduce or enlarge the image size for borderless printing. See 
Printing Borderless Photos for details.

■ Extension Settings: Select a wider platen gap if ink smears on sheets or 
envelopes.

■ Summary: View a list of all your selections.

11. To save your selections for future use, select Save As from the Presets pop-up 
menu.

12. Click Print.

13. To monitor the progress of your print job, click the  printer icon when it 
appears in the dock on the bottom of your desktop. 

If you’re using OS X 10.2.x, click the  Print Center icon instead, then 
double-click Stylus Photo R270 in the Printer List window.

You see a screen like this:

If necessary, you can do one of the following while monitoring the progress of 
your print job:

■ Click the print job, then click Delete to delete it
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■ Click the print job, then click Hold to pause printing

■ Click a print job marked “Hold” and click Resume to resume printing

14. When you’re finished, close the printer window or Print Center.

Customizing Mac OS X Print Settings

You can use advanced settings for color matching or printing at a higher resolution.

1. On the Print Settings window, click Advanced and choose these settings as 
necessary:

Note: For the highest quality on selected papers, you can select Photo RPM 
(5760 × 1440) from the Print Quality pop-up menu. When you select Photo RPM, 
printing will take longer.

2. To save your selections for future use, select Save As from the Presets pop-up 
menu.

3. Click Print.

Select various print 
options here

For color management 
settings, select Color 
Management from the 
pull-down menu

Click here to select your 
Print Quality option
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Printing Multiple Photos or Pages Per Sheet

Note: This feature is not available when you are printing borderless.

1. Open the File menu and select Page Setup. You see a window like this one:

2. Select Stylus Photo R270 in the Format for pop-up menu.

3. Select your paper size and orientation settings, then click OK.

4. Open the File menu and select Print. You see a window like this one:

5. Select Stylus Photo R270 in the Printer pop-up menu.

Click here and 
select Stylus 
Photo R270

Click here and 
select Layout
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6. Select Layout from the pop-up menu. You see a window like this one:

7. Select from the following settings:

■ Pages per Sheet: Prints multiple images or document pages on a single 
piece of paper. Choose from 1, 2, 4, 6, 9, or 16.

■ Layout Direction: Specifies the order in which the pages will be printed on 
the sheet of paper.

■ Border: Prints a border around the pages printed on each sheet. Choose from 
None, Single hairline, Single thin line, Double hairline, or Double thin line.

Select your 
layout settings 
here
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8. Select Print Settings from the pop-up menu. You see a window like this one:

9. Select the appropriate Media Type, Color, and Mode settings.

10. Click Print.

Cancelling Printing

■ Using the Buttons on the Printer

■ Using Your Computer

Using the Buttons on the Printer

Press the paper button to cancel your print job from the printer.
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Using Your Computer

When you start printing, a printer icon appears in the dock on the bottom of your 
desktop.

1. Mac OS X 10.3.x or higher: Click the  printer icon when it appears in the 
dock. 

Mac OS X 10.2.x: Click the  Print Center icon when it appears in the dock, 
then double-click Stylus Photo R270 in the Printer List window.

You see a screen like this:

2. Click the print job, then click Delete to delete it.

Selecting the Correct Paper Type

Your printer automatically adjusts itself for the type of paper you select in your print 
settings. That’s why the paper Type or Media Type setting is so important. It tells 
your printer what kind of paper you’re using and adjusts the ink coverage accordingly.
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The table below lists the settings you should choose for your paper:

For this paper . . .

Select this Type or Media 

Type setting . . .

Plain paper

Epson Bright White Paper
Epson Premium Bright White Paper

Epson Iron-on Cool Peel Transfer paper

Plain Paper / Bright White 
Paper

Epson Ultra Premium Photo Paper Glossy

Epson Ultra Premium Glossy Photo Paper

Ultra Premium Photo Paper 
Glossy

Epson Premium Photo Paper Glossy

Epson Premium Glossy Photo Paper

Premium Photo Paper 
Glossy

Epson Premium Photo Paper Semi-Gloss

Epson Premium Semi-Gloss Photo Paper

Premium Photo Paper 
Semi-Gloss

Epson Photo Paper Glossy

Epson Glossy Photo Paper

Photo Paper Glossy

Epson Premium Presentation Paper Matte

Epson Matte Paper Heavyweight

Epson Premium Presentation Paper Matte Double-Sided

Epson Double-Sided Matte Paper

Premium Presentation 
Paper Matte

Epson Presentation Paper Matte

Epson Photo Quality Ink Jet Paper

Epson Photo Quality Self Adhesive Sheets

Presentation Paper Matte

Epson Ultra Premium Photo Paper Luster

Epson Premium Luster Photo Paper

Ultra Premium Photo Paper 
Luster

Envelopes Envelope
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Printing Borderless Photos

You can print your photos with no margins, extending the image all the way to the 
edges of the page. You get beautiful snapshots and enlargements, without trimming. 

See Choosing Paper for Borderless Photos, then see these sections for instructions:

■ Storing and Displaying Your Prints

■ Windows Vista

■ Windows XP

■ Macintosh OS X

Choosing Paper for Borderless Photos

You can print borderless photos on these papers and sizes:

Paper name Sizes

Paper Type or 

Media Type setting

Epson Ultra Premium Photo Paper 
Glossy

Epson Ultra Premium Glossy Photo 
Paper

4 × 6 in. (10.2 × 15.2 
cm)

Letter (8.5 × 11 in.; 21.6 
× 27.9 cm)

Ultra Premium 
Photo Paper Glossy

Epson Premium Photo Paper Glossy

Epson Premium Glossy Photo Paper

4 × 6 in. (10.2 × 15,2 
cm)

5 × 7 in. (12.7 × 17.7 
cm)

8 × 10 in. (20.3 × 25.4 
cm)

Letter (8.5 × 11 in.; 21.6 
× 27.9 cm)

Premium Photo 
Paper Glossy

Epson Premium Photo Paper 
Semi-Gloss

Epson Premium Semi-Gloss Photo 
Paper

4 × 6 in. (10.2 × 15,2 
cm)

Letter (8.5 × 11 in.; 21.6 
× 27.9 cm)

Premium Photo 
Paper Semi-Gloss
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Note: Print quality may decline in the top and bottom areas of the printout, or the 
area may be smeared when you print on papers other than those listed above. 
Print a single sheet to check the quality before printing large jobs.

Load your paper as shown in Loading Paper.

Storing and Displaying Your Prints

With proper care, photographs from your Epson Stylus printer will last for many 
years. The special Epson Hi-Definition Photographic inks designed for your printer 
provide the ultimate combination of photo quality and longevity when used with 
Epson papers for prints that are properly displayed or stored. For best results, always 
use Epson papers.

As with traditional photos, Epson recommends proper care that will minimize color 
changes and lengthen display life: 

■ Frame prints under glass or a protective plastic sleeve to protect them from 
atmospheric contaminants like humidity, smoke, and high levels of ozone.

■ As with all photographs, keep your prints away from direct sunlight.

■ Keep your prints away from high temperature.

Epson Photo Paper Glossy

Epson Glossy Photo Paper

4 × 6 in. (10.2 × 15,2 
cm)

Letter (8.5 × 11 in.; 21.6 
× 27.9 cm)

Photo Paper Glossy

Epson Premium Presentation Paper 
Matte

Epson Matte Paper Heavyweight

8 × 10 in. (20.3 × 25.4 
cm)

Letter (8.5 × 11 in.; 21.6 
× 27.9 cm)

Premium 
Presentation Paper 
Matte

Epson Presentation Paper Matte

Epson Photo Quality Ink Jet Paper

Letter (8.5 × 11 in.; 21.6 
× 27.9 cm)

Presentation Paper 
Matte

Epson Ultra Premium Photo Paper 
Luster

Epson Premium Luster Photo Paper

Letter (8.5 × 11 in.; 21.6 
× 27.9 cm)

Ultra Premium 
Photo Paper Luster

Paper name Sizes

Paper Type or 

Media Type setting
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■ For proper storage, keep your prints in a photo album or plastic photo storage box 
in acid-free, archival sleeves commonly available from most camera stores.

■ Always keep unused paper in the original package.

You can purchase genuine Epson ink and paper from an Epson authorized reseller. To 
find the nearest reseller, contact your nearest Epson sales office as describe in Where 
to Get Help.

Windows Vista

You can print your photos from an imaging application or you can use the Windows 
Photo Gallery in Windows Vista. 

1. Locate the photo you want to print on your computer.

2. Right-click the photo, highlight Open With, and select Windows Photo 
Gallery.

Print icon
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3. Click the Print icon at the top of the screen, then select Print.

4. Make sure your printer is selected, then choose the size and type of paper that you 
loaded in the printer.

Note: 

If you’re not sure which Paper type to select, see Choosing Paper for Borderless 
Photos.

5. Click Options in the lower right corner of the screen and select Printer 
Properties. 

6. When you see your printer’s properties window, select Photo as the Quality 
Option setting.

7. Click the Borderless check box. Read the message and click OK.

8. Click the Page Layout tab. 

9. If necessary, adjust the Expansion slider in the Borderless box to choose Max, 
Min, or the in-between setting. 

Min retains the entire image in your print, but there may be a small white edge on 
the borders of the print. Max expands the image to ensure that there are no 
unprinted edges, but the edges of the image may not appear in the print. 

Click Options,
then select 
Printer Properties
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10. Click OK. 

11. When you see the Windows Photo Gallery again, click Print.

Windows XP

You can print your photos from an imaging application or you can use the Picture 
and Fax Viewer in Windows XP. 

1. Locate the photo you want to print on your computer.

2. Right-click the photo, highlight Open With, and select Windows Picture and 
Fax Viewer.

3. Click the  Print icon at the bottom of the screen. 

Print icon
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4. Click Next. You see a Picture Selection window:

5. Select the photo(s) you want to print and click Next. You see the Printing 
Options window:

Select EPSON 
Stylus Photo R270 
Series

Click Printing 
Preferences
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6. Select EPSON Stylus Photo R270 Series and click Printing Preferences. You 
see a window like this one:

7. Select Photo as the Quality Option setting.

8. Select one of the following for the paper Type option, to match the paper you’re 
using:

Note: If you’re not sure which Type to select, see Choosing Paper for Borderless 
Photos.

■ Ultra Premium Photo Paper Glossy

■ Premium Photo Paper Glossy

■ Photo Paper Glossy

■ Presentation Paper Matte

■ Premium Photo Paper Semi-Gloss

■ Ultra Premium Photo Paper Luster

■ Premium Presentation Paper Matte

9. Click the Borderless check box. Read the message and click OK.

Click the Borderless 
check box
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10. Select your paper Size setting to match the paper you’re using. See the list of 
supported borderless sizes in Choosing Paper for Borderless Photos.

11. Select Portrait or Landscape as the orientation setting.

12. Click the Page Layout tab. You see a window like this one: 

13. If necessary, adjust the Expansion slider in the Borderless box to choose Max, 
Min, or the in-between setting. 

Min retains the entire image in your print, but there may be a small white edge on 
the borders of the print. Max expands the image to ensure that there are no 
unprinted edges, but the edges of the image may not appear in the print. 

14. Click OK. 

Adjust the Expansion 
slider if necessary
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15. At the Photo Printing Wizard screen, click Next. You see a Layout Selection 
window:

16. Select Full page photo print and click Next to begin printing.

Macintosh OS X

1. Open the File menu and select Page Setup. You see a window like this one:

Full page photo print
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2. Select Stylus Photo R270 in the Format for pop-up menu.

3. Select one of the following settings as your Paper Size:

■ US Letter (Sheet Feeder - Borderless)

■ 8 × 10 (Sheet Feeder - Borderless)

■ 5 × 7 (Sheet Feeder - Borderless)

■ 4 × 6 (Sheet Feeder - Borderless)

4. Select  portrait or  landscape as the orientation setting.

5. Click OK.

6. Open the File menu and select Print. You see a window like this one:

7. Select Stylus Photo R270 in the Printer pop-up menu.

Select Print 
Settings 

Select Stylus 
Photo R270
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8. Select Print Settings from the pop-up menu.

9. Select one of the following Media Types to match the paper you’re using:

Note: If you’re not sure which Media Type to select, see Choosing Paper for 
Borderless Photos.

■ Ultra Premium Photo Paper Glossy

■ Premium Photo Paper Glossy

■ Photo Paper Glossy

■ Presentation Paper Matte

■ Premium Photo Paper Semi-Gloss

■ Ultra Premium Photo Paper Luster

■ Premium Presentation Paper Matte

10. Select Quality (for higher quality) or Speed (for faster printing) using the slider.

Note: The slider is not available for some Media Types.
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11. Select Expansion from the pop-up menu. You see a window like this one:

12. If necessary, adjust the Expansion slider to choose Max, Min, or the in-between 
setting. 

Min retains the entire image in your print, but there may be a small white edge on 
the borders of the print. Max expands the image to ensure that there are no 
unprinted edges, but the edges of the image may not appear in the print. 

13. Click Print.

Printing on CDs and DVDs

Follow the Guidelines for Printing on CDs and DVDs, then see these sections for 
instructions:

■ Cleaning the Rollers

■ Inserting a CD or DVD

■ Windows

■ Macintosh OS X

Caution: 

Use only ink jet-printable CDs and DVDs for printing. Thermal-printable and 
regular CDs and DVDs should not be used with this printer.
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Guidelines for Printing on CDs and DVDs

■ Before using or touching the printed surface of your CDs or DVDs, make sure 
you dry them for 24 hours.

■ Depending on your CD or DVD type, smearing may occur or the printed surface 
may be sticky even after it has dried. If smearing or stickiness occurs, see Adjusting 
the Print Density in Windows or Adjusting the Print Density in Mac OS X, or try 
a different brand of CD or DVD.

■ Moisture on the printable surface of your CDs or DVDs may cause smearing.

■ If you accidentally print on the CD/DVD tray, immediately wipe off the ink.

■ You can set the printable area for your CDs or DVDs using EPSON Print CD. 
Make sure the settings you choose are appropriate for the CD or DVD you are 
printing on; otherwise, you may stain the CD/DVD tray, CD, or DVD.

The printable area of a CD or DVD is shown below:

Note: If you print in the inner hub or outer periphery areas of the disc, the disc or 
CD/DVD tray may get stained with ink:

■ Inner hub area: 18 to 42 mm

■ Outer periphery area: 117 to 120 mm (12-cm CD/DVD), 77 to 80 mm 
(8-cm CD/DVD)

120 mm

18 mm

80 mm

18 mm

12-cm CD/DVD 8-cm CD/DVD
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Cleaning the Rollers

Before you print on a CD or DVD, you should clean the rollers inside the printer.

1. Make sure your printer is turned on and several sheets of letter-size plain paper are 
loaded.

2. Press the paper button to feed a sheet of paper through the printer.

3. Repeat step 2 several times.

Inserting a CD or DVD

Caution: Make sure the data, music, or video is burned on your ink jet-printable 
CD or DVD before you print. Otherwise, dirt or scratches on the surface may 
cause errors when you burn the data.

1. Turn your printer on.

2. Open the front cover, then set the front tray to the CD/DVD position by pulling 
the tray lever down.

Caution: Before you move the tray lever, make sure no paper or other objects are 
on the front tray and the front tray is not extended.

Do not touch the front tray when you move the tray lever.

Do not move the tray lever while the printer is printing.

3. Place the CD or DVD on the CD/DVD tray with the white or printable side 
face-up. Make sure the disc lies flat in the tray.

Caution: Before you position the CD or DVD, make sure that no foreign particles 
or substances are on the CD/DVD tray, as these may damage the disc’s data side.
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To print on a small CD or DVD (8-cm), place the small CD/DVD adapter on 
the tray first, then place the CD/DVD inside the adapter. Make sure the tabs on 
the edge of the adapter fit squarely into the molding of the tray.

Caution: Make sure you always use the small CD/DVD adapter when you print 
on 8-cm CDs or DVDs and that the CD or DVDand adapter lie flat on the tray; 
otherwise the printer may be damaged.

4. Gently insert the CD/DVD tray along the base of the front tray until the arrow 
marks on the CD/DVD tray and the front tray match each other.

12-cm CD/DVD 8-cm CD/DVD

CD adapter
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Caution: Make sure both sides of the CD/DVD tray slide underneath the brackets 
on the front tray.

Caution: Do not insert the CD/DVD tray while the printer is printing; otherwise, 
your printer may be damaged or the surface of the CD or DVD may become dirty 
or scratched.

Windows

Designing a CD or DVD

1. Click Start, point to Programs or All Programs, select EPSON Print CD, then 
select EPSON Print CD again.

Make sure the 
arrow marks 
matchMake sure the 

CD/DVD tray 
slides under 
the bracket 
(on both sides)
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2. To add a background image, click the  background icon. You see the following 
window:

Note: If you have already chosen a background, you see a different window. Click 
Select Image and the window above appears.

3. To select a background image, click the File tab, click Browse to locate the folder 
your images are stored in, then click OK. You see thumbnail images of all the files 
in the folder.

4. Select your image and click OK.
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5. To add text, click the  button.

6. Enter your text and use the tabs to apply formatting and special effects, then click 
OK. (To open the window again, double-click any block of text.)

7. To curve a single line of text, click the text in the main window, then drag the red 
“handle” up or down. Then adjust it using the other handles that appear.

8. When you’re finished, choose Save As from the File menu to save your file.

Note: For additional help with Epson Print CD, open the Help menu in Epson Print 
CD and select Help Topics.
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Printing on a CD or DVD

After you have created your design and loaded a CD or DVD, you’re ready to print.

1. Open the File menu and select Print.

2. Make sure EPSON Stylus Photo R270 Series is selected.

3. Select CD/DVD or CD/DVD Premium Surface as the Media Type setting.

4. Select None as the Print Confirmation Pattern setting.

5. Click Print.

Note: After you print, handle the CD or DVD carefully. To allow the ink to dry, 
wait at least 24 hours before playing the disc or inserting it in a drive. Keep 
printed discs away from moisture and direct sunlight.

Select EPSON 
Stylus Photo 
R270 Series

Select your CD 
type

Click 
None
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Adjusting the Print Position

If your printed images and text are not centered or positioned the way you want on 
your CD or DVD, you may need to adjust the printing position. You can also use 
these steps to check the position before you print on a CD or DVD.

1. Place an extra ink jet-printable CD or DVD on the CD/DVD tray and insert it 
into the printer, as described in Inserting a CD or DVD.

2. Start Epson Print CD.

3. Open the File menu and select Print.

4. Make sure EPSON Stylus Photo R270 Series is selected.

5. Select Print Position Confirmation Pattern as the Print Confirmation Pattern 
setting.

6. Click Print. The confirmation pattern is printed on the check disk or CD or 
DVD.

7. Remove the CD or DVD and measure the distance from the edge of the hole to 
the small cross marks labeled Top and Right. You’ll need a metric ruler with 
millimeters for accurate measurements.
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8. Open the File menu, select Print, then select Adjust Print Position. You see a 
screen like this:

9. Click Enter Values, then input the Top distance (from your measurement) in 
the Height(Top) box. Enter the Right distance (from your measurement) in the 
Width(Right) box.

10. Click OK to save the measurements.

Adjusting the Print Density

If ink smears on your printed CDs or DVDs, you may need to adjust the color 
saturation or ink density. CDs or DVDs from different manufacturers may absorb ink 
differently, so you may need to adjust the density for each type of disc. Follow these 
instructions to print a color saturation check pattern, and then make adjustments as 
necessary.

1. Start Epson Print CD.

2. Open the File menu and select Print.
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3. Insert a test CD or DVD for printing, as described in Inserting a CD or DVD.

4. Make sure EPSON Stylus Photo R270 Series is selected.

5. Select Print Density Confirmation Pattern as the Print Confirmation Pattern 
setting.

6. Click Print.

7. After the pattern is printed, examine the print.

If you need to adjust the color, open the File menu, select Print, and make the 
Print Color Correction setting lighter or darker as necessary. Then, repeat steps 3 
through 7 (but select either Second or Third in the Print Confirmation Pattern 
section, depending on whether you’re printing your second or third pattern on 
the disc).

Note: You can print three density patterns on one disc. Each pattern is printed in 
a different location.

8. Remove the CD or DVD and let it dry for at least 24 hours. Then check the 
saturation levels again.

Note: You can also use the Brightness and Contrast settings in Epson Print CD to 
adjust color saturation. For additional information, open the Help menu in Epson 
Print CD and select Help Topics.

Macintosh OS X

Designing a CD or DVD

1. Open the Applications folder, open the EPSON Print CD folder, then select 
EPSON Print CD.
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2. To add a background image, click the  background icon. You see the following 
window:

3. To select a background image, click Select Background.

4. Locate the folder your images are stored in, select the one you want, then click 
Open.

5. Click OK in the Adjust Background window.
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6. To add text, click the  button.

7. In the Text Settings window, type your text, then use any of the options in the 
window to format it. You can also use options in the Color Settings and Object 
Settings windows.

8. To curve a single line of text, click the text in the main window, then drag the red 
“handle” up or down. Then adjust it using the other handles that appear.

9. When you’re finished, choose Save As from the File menu to save your file.

Note: For additional help with Epson Print CD, open the Help menu in Epson Print 
CD and select EPSON Print CD Help.
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Printing on a CD or DVD

After you have created your design and loaded a CD or DVD, you’re ready to print.

1. Open the File menu and select Print.

2. Click the Select Printer button and select Stylus Photo R270 from the printer 
list, then click OK.

3. Select CD/DVD or CD/DVD Premium Surface as the Media Type setting.

4. Select None as the Test Print Pattern setting.

5. Click Print.

Adjusting the Print Position

If your printed images and text are not centered or positioned the way you want, you 
may need to adjust the printing position. You can also use these steps to check the 
position before you print on a CD or DVD.

1. Place an extra ink jet-printable CD or DVD on the CD/DVD tray and insert it 
into the printer, as described in Inserting a CD or DVD.

2. Start Epson Print CD.

3. Open the File menu and select Print.

4. Make sure Stylus Photo R270 is selected.

5. Select Print Position Check Pattern as the Test Print Pattern setting.

Click here and select 
Stylus Photo R270

Select your CD 
or DVD type

Click None
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6. Click Print, then click OK in the Colors window. The confirmation pattern is 
printed on the check disk or CD.

7. Remove the CD or DVD and measure the distance from the edge of the hole to 
the small cross marks labeled Top and Right. You’ll need a metric ruler with 
millimeters for accurate measurements.
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8. Open the File menu, select Print, then select Position Adjustment. You see a 
screen like this:

9. Click Value Entry, then input the Top distance (from your measurement) in the 
Top Space box. Enter the Right distance (from your measurement) in the Right 
Space box.

10. Click OK to save the measurements.

Adjusting the Print Density

If ink smears on your printed CDs or DVDs, you may need to adjust the color 
saturation or ink density. CDs and DVDs from different manufacturers may absorb 
ink differently, so you may need to adjust the density for each type of disc. Follow 
these instructions to print a color saturation check pattern, and then make 
adjustments as necessary.

1. Open the File menu and select Print.

2. Insert a test CD or DVD for printing, as described in Inserting a CD or DVD.

3. Make sure Stylus Photo R270 is selected.
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4. Select Print Density Check Pattern as the Test Print Pattern setting.

5. Click Print.

6. After the pattern is printed, examine the print.

If you need to adjust the color, open the File menu, select Print, and make the 
Color Correction setting lighter or darker as necessary. Then, repeat steps 2 
through 6 (but select either Second Time or Third Time in the Test Print 
Pattern section, depending on whether you’re printing your second or third 
pattern on the disc).

Note: You can print three density patterns on one disc. Each pattern is printed in 
a different location.

7. Remove the CD or DVD and let it dry for at least 24 hours. Then check the 
saturation levels again.

Note: You can also use the Brightness and Contrast settings in Epson Print CD to 
adjust color saturation. For additional information, open the Help menu in Epson 
Print CD and select EPSON Print CD Help.

Direct Printing from a Digital Camera or 
Mobile Phone

■ Requirements

■ Connecting and Printing

Requirements

■ Your digital camera or mobile phone must be compatible with PictBridge or USB 
DIRECT-PRINT.™ If it isn’t, the red  ink and paper lights flash alternately 
when you connect your camera or phone. Epson cannot guarantee the 
compatibility of any cameras or phones.

■ The file format of your images must be JPEG, and the size of each image must be 
at least 80 × 80 pixels but not more than 9200 × 9200 pixels.
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Connecting and Printing

1. Make sure your Epson Stylus Photo R270 is not printing.

2. Load the type of paper you want to use. See Loading Paper.

3. Connect the USB cable that came with your camera or phone to the external 
interface port on the front of the printer.

4. Turn your camera or phone on.

5. Use your camera or phone to select the photos you want to print, adjust any 
necessary settings, and print your photos. See your camera or phone manual for 
details.
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Maintenance and Transportation

Cleaning the Print Head

If your printouts are unexpectedly light or faint, or you notice light or dark bands 
across your printout, you may need to clean the print head. This unclogs the nozzles 
so they can deliver ink properly. Print head cleaning uses ink, so clean it only if 
quality declines.

You can clean the print head using the  ink button on the printer or using the Head 
Cleaning utility on your computer. You can also run a nozzle check to see if the print 
head needs cleaning. 

Note: Clean the print head only when print quality declines (for example, if you 
see lines in your printout or colors are incorrect or missing).

Before you clean the print head, check the print head nozzles first to confirm that 
the print head needs to be cleaned. This saves ink. For more information, see 
Checking the Print Head Nozzles.

If the red  ink light comes on or flashes, you cannot clean the print head. In this 
case, replace the appropriate ink cartridge first.

Caution: If you don’t use your printer often it is a good idea to print a few pages 
at least once a month to maintain good print quality.

Before you check the print head nozzles or clean the print head, make sure the 
CD/DVD tray is not inserted in the printer, and make sure the front tray is in the 
paper (lower) position. Follow the instructions to reposition the front tray.

■ Checking the Print Head Nozzles

■ Running the Head Cleaning Utility

■ Examining the Nozzle Check Pattern

Checking the Print Head Nozzles

Using Your Computer

1. Make sure the printer is turned on but not printing, and the red  ink light is not 
on. (If the red  ink light is on, you need to replace a cartridge.)
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2. Make sure letter- or A4-size plain paper is loaded in the printer.

3. Windows: Right-click the  printer icon on your taskbar (in the lower right 
corner of your screen). Select Nozzle Check.

Macintosh OS X: Open the Applications folder and select EPSON Printer 
Utility2. Select SP R270 Series in the printer list, click OK, and select Nozzle 
Check.

You see a screen like the following: 

4. Click Print or Next. The nozzle check pattern prints:

5. If there are no gaps or lines, click Finish.

If there are gaps or lines, or the test patterns are faint, click Clean. Then read the 
on-screen instructions and skip to step 3 in Running the Head Cleaning Utility 
Using Your Computer to clean the nozzles.

Print head 
needs to be 
cleaned:

Print head does 
not need to be 
cleaned:
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Using the Buttons on the Printer

1. Make sure the printer is turned on but not printing, and the red  ink light is not 
on. (If the red  ink light is on, you need to replace a cartridge.)

2. Turn the printer off.

3. Make sure letter- or A4-size plain paper is loaded in the printer.

4. Hold down the paper button, then press the power button. Continue 
holding down the paper and power buttons until the green power light 
starts to flash, then release them.

The nozzle check pattern prints:

5. If there are no gaps or lines, the print head does not need to be cleaned.

Paper 
button

Power 
button

Print head 
needs to be 
cleaned:

Print head does 
not need to be 
cleaned:
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If there are gaps or lines, or the test patterns are faint, follow the steps in Running 
the Head Cleaning Utility to clean the nozzles.

Running the Head Cleaning Utility

Using Your Computer

1. Make sure the printer is turned on but not printing, and the red  ink light is off. 
(If the red  ink light is flashing or on, you need to replace a cartridge.)

2. Windows: Right-click the  printer icon on your taskbar (in the lower right 
corner of your screen). Select Head Cleaning.

Macintosh OS X: Open the Applications folder and select EPSON Printer 
Utility2. Select SP R270 Series in the printer list, click OK, and select Head 
Cleaning.

You see a screen like the following: 

3. Click Start or Next.

Cleaning takes several seconds. The printer runs a head cleaning cycle and the 
green power light flashes.

Caution: Never turn off the printer while head cleaning is in progress. You may 
damage it.

Do not insert the CD/DVD tray until cleaning has finished.
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4. When the green  power light stops flashing, make sure paper is loaded in the 
printer, then do the following:

Windows: Click Print Nozzle Check Pattern, then click Print. 

Macintosh OS X: Click Confirmation, then click Next.

The nozzle check pattern prints (see Examining the Nozzle Check Pattern for 
details).

5. If there are no gaps or lines, click Finish.

If there are still gaps or lines, or the test patterns are faint, click Clean to clean the 
print head again. 

If you don’t see any improvement after cleaning four times, turn the printer off 
and wait overnight. This allows any dried ink to soften. Then, try cleaning the 
print head again.

If you still don’t see any improvement, refer to Problems and Solutions.

Using the Buttons on the Printer

1. Make sure the printer is turned on but not printing, and the red  ink light is off. 
(If the red  ink light is flashing or on, you need to replace a cartridge.)

2. Hold down the  ink button on the printer for approximately 3 seconds.

The printer runs a head cleaning cycle and the green power light flashes. 
Cleaning takes several seconds.

Caution: Never turn off the printer while head cleaning is in progress. You may 
damage it.

Do not insert the CD/DVD tray until cleaning has finished.

3. When the green  power light stops flashing, make sure paper is loaded in the 
printer, then print a nozzle check to determine whether you need to clean the 
print head again. See Checking the Print Head Nozzles for more information.

If you don’t see any improvement after cleaning four times, turn the printer off 
and wait overnight. This allows any dried ink to soften. Then, try cleaning the 
print head again.

If you still don’t see any improvement, refer to Problems and Solutions.
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Examining the Nozzle Check Pattern

Examine the nozzle check pattern you printed. Each staggered line should be solid, 
with no gaps, as shown.

■ If your printout looks okay, you’re done. 

■ If you see any gaps (as shown below), clean the print head again. 

Replacing an Ink Cartridge

■ When the red  ink light flashes, one or more ink cartridges are low on ink.

■ When the red  ink light stays on, you need to replace the cartridge(s).

You’ll also see a message on your screen when you print telling you which cartridge is 
low or expended.

When a cartridge is more than six months old, you may need to replace it if printouts 
don’t look their best. If the quality doesn’t improve after cleaning and aligning the 
print head, you can replace the cartridge even if the red  ink light is off.

■ Checking the Ink Supply

■ Purchasing Ink Cartridges

■ Ink Cartridge Precautions

■ Removing and Installing Ink Cartridges
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Checking the Ink Supply

Note: Epson cannot guarantee the quality or reliability of non-genuine ink. If you 
install non-genuine ink cartridges, the ink cartridge status will not be displayed.

If any of the ink cartridges installed in the printer is broken, incompatible, or 
improperly installed, the ink cartridge status will not be accurately displayed.

When you use your printer as a shared printer on a network with the following 
combinations of computers, the client operating systems may not be able to 
communicate directly with the printer and some functions will not be available for 
the client. 

To check your ink supply, do the following:

■ Windows: Double-click the  printer icon on your taskbar (in the lower right 
corner of your screen). You see a window like the following:

Server Client

Windows Vista, XP/XP Professional x64 
Edition

Windows Me/98SE/2000

Windows Me/98SE/2000 Windows Vista, XP/XP Professional x64 
Edition
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■ Macintosh OS X: Open the Applications folder and select EPSON Printer 
Utility2. Select SP R270 Series in the printer list, click OK, and select EPSON 
StatusMonitor.

You see a window like this:

Note: To update the ink cartridge status, click Update.

Purchasing Ink Cartridges

Epson offers two different capacity cartridges for each color in your Epson Stylus 
Photo R270 Series.

Use these Epson ink cartridges within six months of installing them and before the 
expiration date on the package.

Ink cartridge Part number 

Black 82 (T082120)

Cyan 82 (T082220)

Magenta 82 (T082320)

Yellow 82 (T082420)

Light Cyan 82 (T082520)

Click a cartridge image to 
display information about it.



94

Note: You may use any combination of cartridge sizes. (If you’ve installed a 81 
black cartridge, you can still use a 82 magenta cartridge, for example.)

To ensure the best results, use genuine Epson ink cartridges and do not refill them. 
Other products may cause damage to your printer not covered by Epson’s warranty.

You can purchase genuine Epson ink and paper from an authorized Epson reseller. To 
find the nearest reseller, please call your nearest Epson sales office as described in 
Where to Get Help

Removing and Installing Ink Cartridges

Before you remove or install an ink cartridge, read the Ink Cartridge Precautions.

Be sure you have a new ink cartridge before you begin. Once you start replacing a 
cartridge, you must complete all the steps in one session.

Caution: Leave the expended cartridge installed until you have obtained a 
replacement, or the ink remaining in the print head nozzles may dry out. To 
ensure good results, use genuine Epson ink cartridges and do not refill them. 
Other products may cause damage to your printer not covered by Epson’s 
warranty.

Note: Do not open the ink cartridge packages until you are ready to install the ink. 
Cartridges are vacuum packed to maintain reliability.

1. Make sure the CD/DVD tray is not inserted in the printer, and make sure the 
front tray is in the paper (lower) position. Follow the instructions to reposition 
the front tray.

Light Magenta 82 (T082620)

High-Capacity Black 81 (T081120)

High-Capacity Cyan 81 (T081220)

High-Capacity Magenta 81 (T081320)

High-Capacity Yellow 81 (T081420)

High-Capacity Light Cyan 81 (T081520)

High-Capacity Light Magenta 81 (T081620)

Ink cartridge Part number 
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2. Make sure the printer is turned on. (The green  power light should be on, but 
not flashing.) Then open the printer cover.

3. Press and release the  ink button. 

■ If you are replacing a low or expended cartridge, the print head moves to the 
ink cartridge check position, and the cartridge that needs to be replaced stops 
under the  mark. The green  power light begins to flash.

■ If you are replacing a cartridge before it is low or expended, the print head 
moves directly to the ink cartridge replacement position. Skip to step 5.

Note: Don’t hold down the  ink button for more than 3 seconds, or the printer 
will start to clean the print head. 
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Caution: To avoid damaging the printer, never move the print head by hand.

Do not touch the area shown below when you are changing ink cartridges.

4. Press the  ink button again.

■ If more than one cartridge is low or expended, the next cartridge moves under 
the  mark. Repeat this step.

■ If all the low or expended cartridges have been identified, the print head 
moves to the ink cartridge replacement position.

Note: If an ink cartridge is low, you may continue to use it until it is expended.

You can also use the Status Monitor to check ink cartridge status. See Checking 
the Ink Supply for more information.
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5. Remove the new cartridge from its package.

Caution: Be careful not to break the hooks on the side of the ink cartridge when 
you remove it from the package.

Always install an ink cartridge immediately after removing the old cartridge. If the 
cartridge is not installed promptly, the print head may dry out and be unable to 
print.

Do not touch the green IC chip on the side of the cartridge. This can damage the 
ink cartridge.

6. Remove the yellow tape from the bottom of the ink cartridge.
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Caution: You must remove the yellow tape from the cartridge before you install 
it; otherwise, print quality may decline or you may not be able to print.

If you have installed an ink cartridge without removing the yellow tape, take the 
cartridge out of the printer, remove the yellow tape, and then reinstall it.

Do not remove the transparent seal from the bottom of the cartridge; otherwise, 
the cartridge may become unusable.

Do not remove or tear the label on the cartridge; otherwise, ink will leak.
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7. Open the cartridge cover.

8. Squeeze the back tab of the used cartridge as you lift it straight up and out of the 
printer and dispose of it properly. Don’t take the cartridge apart or try to refill it.

Warning: If ink gets on your hands, wash them thoroughly with soap and water. 
If ink gets in your eyes, flush them immediately with water. If discomfort or vision 
problems continue after a thorough flushing, see a doctor immediately.
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9. Lower the new ink cartridge into the holder. Push down gently until the cartridge 
clicks into place.

10. If you need to replace other ink cartridges, repeat steps 5 through 9 before 
continuing with step 11.

11. Close the cartridge cover.



101

12. Close the printer cover and press the  ink button. The printer begins charging 
the ink delivery system.

The green power light flashes and the printer makes noise. Charging takes 
about one and a half minutes. When it’s finished, the green power light stops 
flashing and stays on, and the red  ink light goes out.

Caution: Never turn off the printer while the green power light is flashing, 
unless the print head hasn’t moved or the printer hasn’t made noise for more 
than 5 minutes.

Do not insert the CD/DVD tray until ink charging is complete.

Note: If the red  ink light flashes after the print head moves to its home (far 
right) position, the ink cartridge may not be installed properly. Press the  ink 
button two or more times (until the print head moves to the ink cartridge 
replacement position), open the cartridge cover, and press down the ink cartridge 
until it clicks into place.
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Ink Cartridge Precautions

Warning: Keep ink cartridges out of the reach of children. Do not allow children 
to drink from or handle the cartridges.

The ink cartridges are designed to contain any excess ink and prevent leakage. 
Careful handling is recommended, however. Do not touch the supply port of the 
ink cartridge or its surrounding area.

If ink gets on your hands, wash them thoroughly with soap and water. If ink gets 
in your eyes, flush them immediately with water. If discomfort or vision problems 
continue after a thorough flushing, see a doctor immediately.

Caution: Don’t remove the cartridge label, or ink will leak. 

Don’t remove the green IC chip from the cartridge. Installing a cartridge without 
an IC chip can damage the printer. Avoid touching the green IC chip, as this can 
damage the ink cartridge.

If you remove an ink cartridge temporarily, protect the ink supply port on the 
bottom of the cartridge from dirt and dust. Place it in a small box, or, if you have 
the original packaging, return it to its own box.

Store ink cartridges in the same environment as the printer. Stand the cartridges 
upright; the label identifying the color should be on top. 

Note: You cannot continue printing with one ink cartridge expended, even if the 
other cartridges still contain ink. Before printing, replace the expended cartridge.

This printer uses ink cartridges equipped with IC chips that monitor the amount of 
ink used by each cartridge. Cartridges are usable even if they are removed and 
reinserted. Some ink is consumed each time cartridges are inserted, however, 
because the printer automatically checks their reliability.

If you remove a cartridge that is low (for which you have received an “Ink low” 
message), you cannot reuse it.

Ink is consumed during the following operations: print head cleaning, 
self-cleaning (performed when the printer is turned on), and ink charging (when 
an ink cartridge is installed).
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Aligning the Print Head

If your printouts look grainy or blurry, or you see light or dark lines, you may need to 
align the print head.

Note: You may also see lines in your printouts if your cartridges are low on ink or 
you need to clean the print head.

Before you align the print head, make sure the CD/DVD tray is not inserted in the 
printer, and make sure the front tray is in the paper (lower) position. Follow the 
instructions to reposition the front tray.

1. Turn on the printer.

2. Make sure none of the lights on the printer are indicating errors.

3. Load several sheets of paper.

4. Windows: Right-click the  printer icon on your taskbar (in the lower right 
corner of your screen). Select Print Head Alignment.

Macintosh OS X: Open the Applications folder and select EPSON Printer 
Utility2. Select SP R270 Series in the printer list, click OK, and select Print 
Head Alignment.

5. Follow the instructions on the screen to print an alignment sheet. You see a 
window like this one:
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6. Look at the four sets of patterns in your printout. For each set, look at the printed 
squares to determine which one in each set is the most even, with no streaks or 
lines, and enter its number in the corresponding box on the screen.

If every square in a set contains a line or lines, select the square with the thinnest 
line or lines. Then click Realignment and Print to print another alignment sheet 
and repeat this step.

7. Click Finish to close the Print Head Alignment utility.

Cleaning the Printer

To keep your printer working at its best, you should clean it several times a year.

1. Turn off the printer, unplug the power cord, and disconnect the USB cable.

2. Remove all the paper, then use a soft brush to clean the sheet feeder. See Printer 
Parts for more information on the location of the sheet feeder.

3. If the outer case or inside of the sheet feeder is dirty, clean it with a soft cloth 
dampened with mild detergent. Keep the printer cover closed to prevent water 
from getting inside.

4. If ink accidentally gets inside the printer, wipe it off with a damp cloth in the area 
shown below.

Warning: Don’t touch the gears or any other parts inside the printer.

Clean here
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Caution: Never use a hard or abrasive brush, or benzine, alcohol, or paint thinner 
for cleaning; they can damage the printer components and case.

Don’t get water on the printer components and don’t spray or apply lubricants, 
oils or grease inside the printer.

Don’t use any cleaning sheets included with special paper; they may jam inside 
the printer.

Transporting the Printer

If you need to ship your printer, you must prepare it for transportation by packing the 
printer in its original box or one of a similar size.

Caution: When storing or transporting the printer, do not tilt it, stand it up 
vertically, or turn it upside down. Otherwise, ink may leak from the cartridges.

Leave the ink cartridges installed. Removing the cartridges can dehydrate the 
print head and may prevent the printer from printing.

1. Turn on the printer. Wait until the print head returns to the home (far right) 
position, then close the printer cover.

2. Turn off the printer and unplug its power cord. Then disconnect the power cord 
and USB cable from the printer.

3. Open the printer cover. Secure the print head with tape, as shown below, then 
close the printer cover.
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4. Remove any paper from the printer, then push down the paper support extension 
and close the paper support.

5. Repack the printer and its attachments in the original box using the protective 
materials that came with them.

Keep the printer level as you transport it. 

After transporting the printer, remove the tape securing the print head. Then plug in 
your printer, turn it on, and test it. If you notice a decline in print quality, clean the 
print head; if output is grainy or blurry, align the print head.
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Solving Problems

Diagnosing Printer Problems

■ Checking the Printer’s Lights

■ Running a Printer Check

Checking the Printer’s Lights

If the printer’s lights come on or flash, check the explanations listed below.

Lights Explanation

Green power 
light flashes

The printer is receiving a print job, replacing an ink cartridge, 
charging ink, or cleaning the print head.

Power light

Paper out light

Ink light
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Red paper out 
light is on and green 

power light 
flashes

If you’re printing on paper, your paper ran out or multiple pages 
have fed at once. Make sure you push the tray lever up to set 
the front tray to the paper (lower) position. Then, load more 
paper and press the paper button to resume printing.

If you’re printing on a CD or DVD, the CD/DVD tray is not 
inserted. Follow the instructions in Inserting a CD or DVD to 
insert the tray, then press the paper button.

Red paper out 
light and green 

power light flash

If you’re printing on paper, it is jammed in the printer. Press the 
paper button to eject the paper. If that doesn’t work, turn 

off the printer, open the cover, and pull the paper out from the 
front, including any torn pieces. Then turn on the printer, reload 
paper, and press the paper button.

If you’re printing on a CD or DVD, the CD/DVD tray has not 
ejected. Pull out the tray and press the paper button.

Red ink light 
flashes

One of the cartridges is nearly expended. Check the message 
that appears on your screen to determine which cartridge is 
nearly expended or follow the instructions in Checking the Ink 
Supply. Make sure you have a replacement cartridge.

Red ink light and 
green power light 
are on

One of the cartridges is expended or not installed. Make sure 
you have a replacement cartridge, then follow the steps in 
Replacing an Ink Cartridge to install it.

If you have just installed a new cartridge, it may be incompatible 
with the printer or incorrectly installed. Reinstall it or replace it 
with the correct cartridge, as described in Replacing an Ink 
Cartridge.

Green power 
light is off; red 

paper out and 
ink lights flash

Paper may be blocking movement of the print head. Turn off 
the printer, then open the cover and remove any jammed paper 
or other foreign objects. Turn the printer back on again. If the 
lights are still on, contact Epson as described in Where to Get 
Help.

Green power 
light flashes; red 

paper out and 
red ink lights flash 
rapidly

The front tray is not in the correct position.

Before you turn on the printer or print on paper, push the tray 
lever up to set the front tray to the paper (lower) position.

Before you print on a CD or DVD, pull the tray lever down to set 
the front tray to the CD/DVD position.
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Running a Printer Check

You can run a printer check to determine whether a problem comes from the printer 
itself or some other source.

Before you run a printer check, make sure the CD/DVD tray is not inserted in the 
printer, and make sure the front tray is in the paper (lower) position. Follow the 
instructions to reposition the front tray.

1. Make sure no lights are indicating errors.

2. Turn off both the printer and computer. Then disconnect the USB cable from the 
printer.

3. Make sure letter- or A4-size plain paper is loaded in the printer.

Red paper out 
and red ink light 
flash alternately and 
green power light 
is on

An unsupported device is connected to the EXT. I/F USB port. 
Only devices compatible with PictBridge or USB DIRECT-PRINT 
can be connected to this port. See Direct Printing from a Digital 
Camera or Mobile Phone.

Red paper out 
and red ink light 
flash alternately and 
green power light 
is off

The printer may have an internal error. Turn off the printer, wait 
a few seconds, and turn it on again. If the lights are still flashing, 
contact Epson as described in Where to Get Help.
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4. Hold down the paper button, then press the power button. Continue 
holding down the paper and power buttons until the green power light 
starts to flash, then release them.

A test page prints showing the printer’s ROM version number, an ink counter 
code, and a nozzle check pattern. (If the pattern has gaps, you need to clean the 
print head.)

■ If the test page prints, the problem probably lies in your software settings, the 
cable, or your computer. It’s also possible that your software may not be 
installed correctly. Follow the instructions in Uninstalling Printer Software, 
then see your Start Here sheet for instructions on reinstalling the printer 
software.

■ If the test page doesn’t print, you may have a problem with your printer. Try 
the suggestions in Problems and Solutions. If nothing works, contact Epson as 
described in Where to Get Help.

5. Turn off the printer after it prints the test page. Then reconnect the cable and 
turn on your printer and computer.

Problems and Solutions

■ Setup and Software Installation Problems

Paper 
button

Power 
button
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■ Printer Problems

■ Print Quality Problems

■ Paper or CD/DVD Tray Feeding Problems

■ Miscellaneous Printout Problems

Setup and Software Installation Problems

Tip: It’s a good idea to check Epson’s support website periodically for free 
updates to your Epson Stylus Photo R270 Series printer software. Download 
instructions are posted for your convenience. With Windows, you can also click 
Start or [Windows Vista "Start" icon], select Programs or All Programs, select 
EPSON, and click EPSON Stylus Photo R270 Series Driver Update for printer 
driver updates.

The printer makes noise after ink cartridge installation.

■ The first time you install ink cartridges, the printer must charge its print head for 
a minute or so. Wait until charging finishes (the green power light stops 
flashing) before you turn off the printer, or it may charge improperly and use 
excess ink the next time you turn it on. 

If the print head stops moving or the printer stops making noise, but the green 
power light is still flashing after 5 minutes, turn off the printer. If the light is 

still flashing when you turn it back on, contact Epson as described in Where to 
Get Help.

■ Turn off the printer, then make sure the ink cartridges are inserted completely 
and the ink cartridge cover is closed completely. Also make sure no packing 
material remains in the printer. Wait a moment, then turn the printer back on to 
clear the error.

You’re having problems installing the printer software.

■ Make sure your printer is turned on and the cable is securely connected at both 
ends. Then carefully follow the installation instructions on the Start Here sheet. 
Also make sure your system meets the requirements listed in System 
Requirements.

■ Close your other programs, including any screen savers and virus protection 
software, and install the software again.

http://www.latin.epson.com
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■ If you’re using Windows 2000 and you see an error message or your software 
doesn’t install correctly, you may not have software installation privileges. Contact 
your System Administrator.

■ If you’re using Windows, make sure your system was not upgraded from 
Windows 95. The USB Printer Device Driver may not install correctly.

■ If you are using a Macintosh and you do not see the printer name in the Format 
for menu on the Page Setup screen, you may need to set up your printer in the 
Printer Setup Utility or Printer Center. See the Start Here sheet for instructions.

■ Make sure the USB Controller is working properly in Device Manager. See your 
Windows help system for details. If it’s not working, contact your computer 
manufacturer.

■ If you’re printing over a network, see Setting Up Network Printing for 
instructions.

Printer Problems

Only the green power light is on, but nothing prints.

■ Make sure the USB cable is connected securely at both ends and meets the system 
requirements.

■ Run a printer check. If the test page prints, make sure your software is installed 
correctly. You may need to uninstall your printer software and then reinstall it.

■ Make sure there is no packing material in the printer.

■ If you’re trying to print a large image, your computer may not have enough 
memory. Try reducing the resolution of your image or printing the image at a 
smaller size. You may need to install more memory in your computer.

■ If you’re using Windows Me or 98SE, you may need to clear stalled print jobs 
from the Spool Manager. For instructions, see Using Epson Spool Manager in 
Windows 98SE or Me.

■ If you print continuously for an extended period, the paper may temporarily stop 
feeding or the print head carriage may pause for a while to prevent the printer 
mechanism from overheating and being damaged. If this happens, you can 
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continue to print but Epson recommends that you stop and leave the printer on 
for about 30 minutes. After 30 minutes, turn the printer off and on and it should 
print at normal speed.

The printer sounds as though it is printing, but nothing prints.

■ If you’re using Windows, make sure your printer is selected. For Macintosh OS X, 
make sure your printer is selected in the Page Setup and Print windows. 

■ The print head nozzles may need cleaning. For instructions, see Checking the 
Print Head Nozzles.

■ Make sure the printer software settings are appropriate for the paper size you’re 
using.

■ The printer won’t operate properly if it’s tilted or at an angle. Place it on a flat, 
stable surface that extends beyond the printer base in all directions.

■ You may need to uninstall your printer software and then reinstall it. See 
Uninstalling Printer Software for instructions.

Your printer makes noise when you turn it on or after it has been sitting for 
awhile.

Your printer is performing routine maintenance.

You don’t see the  printer icon in the lower right corner of your screen 
(taskbar) in Windows.

Try restarting your computer. If you still don’t see the icon, follow these steps:

1. Do one of the following:

Windows Vista: Click the  button, select Control Panel, select Hardware 
and Sounds, then select Printer.

Windows XP: Click Start, select Control Panel, then select Printers and Faxes 
(or Printers and Other Hardware and then Printers and Faxes).

Windows Me, 98SE, and 2000: Click Start, point to Settings, then select 
Printers.

2. Right-click your printer icon and select Printing Preferences or Properties.

3. Click the Maintenance tab.
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4. Click the Speed & Progress button, then click the Monitoring Preferences 
button.

5. Click the Shortcut Icon box. Then click OK in each of the open windows to 
close them.

Printing is too slow.

Make sure your system meets the requirements listed in System Requirements. If 
you’re printing a high-resolution image, you need more than the minimum 
requirements listed. You may also need to:

■ Clear space on your hard drive or run a defragmentation utility.

■ Close programs that you’re not using.

■ Increase your system’s memory.

■ Uninstall the printer software and then reinstall it.

For the fastest printing, try these tips:

■ Make sure the paper type selected in your printer settings is appropriate for the 
type of paper you’re using.

■ Select Grayscale in your printer settings if your document doesn’t include color.

■ For Windows, choose Draft as your Quality Option.

■ For Macintosh, set the Quality/Speed slider to Speed.

■ If your printer is connected to a USB hub, disconnect unused USB devices.

■ If you’re using Windows, you can also increase print speed by selecting certain 
settings in the Speed & Progress window:

1. Right-click the  printer icon in the lower right corner of your screen 
(taskbar) and select Printer Settings.

Note: If you don’t see the icon, see You don’t see the printer icon in the 
lower right corner of your screen (taskbar) in Windows.

2. Click the Maintenance tab.



115

3. Click the Speed & Progress button. The following screen appears:

The table below lists the Speed & Progress settings that affect print speed.

The red  ink light is flashing or on after you replace the cartridge.

Make sure the ink cartridges are installed properly.

1. Open the printer cover.

2. Press the  ink button two or more times until the print head moves to the ink 
cartridge replacement position.

Speed & Progress Setting Faster Slower

High Speed Copies On Off

Always spool RAW datatype (Windows Vista, XP and 
2000)

On Off

Page Rendering Mode (Windows Vista, XP and 2000) On Off

Print as Bitmap (Windows Vista, XP and 2000) On Off
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3. Open the cartridge cover and push each ink cartridge down (you may hear a 
cartridge click into place if it was incorrectly installed the first time).

4. Close the cartridge and printer covers.

5. Press the  ink button.

Print Quality Problems

You see banding (light lines).

■ The print head nozzles may need cleaning. 

■ Select a higher Quality Option or Print Quality and turn off High Speed mode. 
See Printing in Windows, or Printing with Macintosh OS X.

■ Make sure the paper Type or Media Type setting matches the paper you loaded; 
see Selecting the Correct Paper Type for guidelines.

■ Make sure the printable side of the paper is face up. It’s usually brighter or whiter.

■ The ink cartridges may need replacing.

■ Make sure you’re using genuine Epson ink cartridges and you use them within six 
months after you open the packages.

■ If you have a Macintosh, try using Automatic mode. See Printing with Macintosh 
OS X for instructions.

■ Align the print head.
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Your printout is blurry or smeared.

■ Make sure your paper isn’t damp or curled, or loaded face down (the printable 
side should be face up).

■ Make sure your paper is not damaged, dirty, or too old.

■ Make sure the paper Type or Media Type setting matches the paper you loaded; 
see Selecting the Correct Paper Type for guidelines.

■ When printing on special paper, check the instructions in the paper package. You 
may need to use an included support sheet or load your paper one sheet at a time.

■ Remove each sheet from the front tray as it is printed.

■ Make sure your paper meets the specifications listed in Paper.

■ Use Epson papers to ensure proper saturation and absorption of genuine Epson 
inks.

■ Make sure you’re using genuine Epson ink cartridges.

■ The printer won’t operate properly if it’s tilted or at an angle. Place it on a flat, 
stable surface that extends beyond the printer base in all directions.

■ The print head nozzles may need cleaning. 

■ Align the print head.

■ Avoid handling printouts on glossy paper for a few hours to allow the ink to set.

■ If ink smears on the back of a printout, clean the inside of the printer.

■ If you are using double-sided paper and printing heavily saturated or dark images 
on the front side of the paper, you may notice that smudges or marks appear on 
the front when you print the second side. If one side of the paper will contain a 
lighter image or text, print that side first to eliminate marks or smudging.
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■ Clear the High Speed check box in your printer settings.

■ Select Thick paper and envelopes in your printer settings:

Windows:

1. Right-click the  printer icon in the lower right corner of your screen 
(taskbar) and select Printer Settings.

Note: If you don’t see the icon, see display the printer icon for instructions on 
making it appear.

2. Click the Maintenance tab.

3. Click the Printer and Option Information button, then click Thick paper 
and envelopes.

4. Click OK, then click OK again.

Macintosh OS X:

1. Open the File menu in your program and select Print.

2. Click Copies & Pages and select Extension Settings from the pop-up 
menu.

3. Click Thick paper and envelopes, then click Print.

■ Load a new sheet of plain paper and press the paper button to eject it. Do this 
several times. If you still have a problem, ink may have leaked inside the printer, 
and you need to clean it. See Cleaning the Printer for instructions.

■ You may need to uninstall your printer software and then reinstall it. See 
Uninstalling Printer Software for instructions.

Your printout is faint or has gaps.
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■ The print head nozzles may need cleaning. 

■ The ink cartridges may be old or low on ink. See Replacing an Ink Cartridge for 
details. 

■ Make sure the paper Type or Media Type setting matches the paper you loaded. 
See Selecting the Correct Paper Type for guidelines.

■ Make sure your paper isn’t damaged, old, dirty, or loaded face down. If it is, 
reload a new stack of paper with the printable side up; it is usually brighter or 
whiter than the other side. For best results, use genuine Epson paper.

You see wrong or missing colors.

■ Clear the Grayscale setting in your printer settings (for Windows). Change the 
ink setting in your printer settings to Color (for Macintosh).

■ The print head nozzles may need cleaning.

■ The ink cartridges may be old or low on ink. See Replacing an Ink Cartridge for 
details.

■ If you’re using Windows, try turning off the PhotoEnhance setting.

■ For Macintosh, try using Automatic mode.

■ Try changing the Gamma setting; see Customizing Windows Print Settings or 
Customizing Mac OS X Print Settings.

■ After you print, the colors on your printout will take some time to set as the ink 
dries. During this time, the colors may look different than you expect. To reduce 
the drying time, avoid stacking your prints on top of each other.

■ Your printed colors can never exactly match your on-screen colors. However, you 
can use a color management system to get as close as possible. Try using the ICM 
(Windows) or ColorSync (Macintosh) setting. 

■ For best results, use genuine Epson ink and paper.

Your printout is grainy.

■ Make sure the printable side of the paper is face up. It’s usually brighter or whiter.

■ Try using a higher quality paper or select a higher Quality Option or Print 
Quality setting. See Printing in Windows or Printing with Macintosh OS X.
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■ Align the print head.

■ You may need to increase the image resolution or print it in a smaller size; see 
your software documentation.

Your printout has a slight slant.

■ If you have selected Fast Economy in your advanced printer settings, select 
Economy instead.

■ Make sure you have loaded the paper correctly. See Loading Paper.

■ Align the print head.

There are scratches on your print.

If you’re printing on glossy paper, prints may be scratched if not handled properly. 
Don’t place objects on top of your prints, and be careful not to scratch them with 
your fingernails. For best results, frame your prints under glass.

Paper or CD/DVD Tray Feeding Problems

Paper doesn’t eject fully or is wrinkled.

■ If the paper doesn’t eject fully, you may have set the wrong paper size. Press the 
paper button to eject the paper, and then select the correct paper size.

■ If it’s wrinkled when it ejects, the paper may be damp or too thin. See the Paper 
specifications.

Note: Store any unused paper in its original packaging in a dry area.

Paper doesn’t feed correctly or jams in the printer.

■ Make sure the paper support extension is pulled up.

■ If paper doesn’t feed, remove it from the sheet feeder. Reload it against the right 
edge, behind the tabs, then slide the left edge guide against the paper.

■ If multiple pages feed at once, remove the paper from the sheet feeder, fan the 
edges to separate the sheets, then reload it.



121

■ If paper jams, press the paper button for several seconds to clear the jam. If 
that doesn’t work, open the cover and remove any jammed paper, including small 
pieces that may have torn off. Reload the paper and press the paper button.

■ Heavily saturated prints may curl, causing a paper jam when printing on both 
sides of the paper.

If your paper loads incorrectly or jams frequently:

■ Use new, smooth, high-quality paper, loaded printable side up. Make sure the 
paper is not curled, creased, wrinkled, too thin, or too old.

■ Fan the edges of the stack of paper to separate the sheets.

■ Don’t load paper above the arrow mark inside the left edge guide.

■ If you’re using special paper, make sure you’ve followed any loading instructions 
that came with the paper. Also, make sure the number of sheets in the paper stack 
does not exceed the limit specified for the paper. For more information, see 
Special Papers.

■ Place the paper against the right edge behind the tab. Slide the left edge guide 
against it, but not too tightly.

■ If you’re printing on both sides of the paper, try loading fewer sheets.

■ Store paper flat to prevent curling.

■ The printer won’t operate properly if it’s tilted or at an angle. Place it on a flat, 
stable surface that extends beyond the printer base in all directions.

The CD/DVD tray is ejected or not fed correctly when a print job is sent.

■ Reinsert the CD/DVD tray correctly. See Inserting a CD or DVD.

■ If the tray is ejected when you start a print job, the printer is not ready. Wait until 
you see a message on your screen asking you to insert the tray. Then reinsert the 
tray and press the paper button.

CD/DVD Printing Problems

Images and text are not centered on the CD/DVD.

Adjust the Print position. For more information, see Adjusting the Print Position 
(Windows) or Adjusting the Print Position (Macintosh).
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Ink smears on the CD/DVD or printing is too light.

■ Make sure you’re using ink jet-printable CDs or DVDs.

■ Handle the disc carefully and allow the ink to dry for at least 24 hours before 
playing the disc or inserting it in a drive.

■ Adjust the print density. For more information, see Adjusting the Print Density 
(Windows) or Adjusting the Print Density (Macintosh).

■ Adjust the brightness or contrast. See the Epson Print CD on-screen help.

Printed CDs or DVDs are dirty.

Clean the rollers. For more information, see Cleaning the Rollers.

The CD/DVD won’t feed into the printer.

Make sure you gently insert the CD/DVD tray along the base of the front tray until 
the arrow marks on the CD/DVD tray and the front tray match each other. Make 
sure both sides of the CD/DVD tray slide underneath the brackets on the front tray. 
For more information, see Inserting a CD or DVD.

Miscellaneous Printout Problems

The image is inverted, as if viewed in a mirror.

■ Turn off the mirror setting in your application program.

■ Turn off the Mirror Image setting in your printer settings:

Note: (If you’re printing on Epson Iron-on Cool Peel Transfer paper, the image 
should be inverted.)

Windows:

1. Right-click the  printer icon in the lower right corner of your screen 
(taskbar) and select Printer Settings.

Note: If you don’t see the icon, see display the printer icon for instructions on 
making it appear.

2. Click the Page Layout tab.

3. If it’s selected, click Mirror Image to turn the setting off, then click OK.
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Macintosh OS X:

1. Open the File menu in your program and select Print.

2. Click Copies & Pages and select Print Settings from the pop-up menu.

3. Click Advanced.

4. If it’s selected, click Mirror Image to turn the setting off, then click Print.

■ You may need to uninstall your printer software and then reinstall it. See 
Uninstalling Printer Software.

The printer prints blank pages.

■ If you’re using Windows, make sure your printer is selected. For Macintosh OS X, 
make sure your printer is selected in the Page Setup and Print windows. 

■ The print head nozzles may need cleaning. For instructions, see Checking the 
Print Head Nozzles.

■ Make sure the printer software settings are appropriate for the paper size you’re 
using.

■ If you’re using Windows, activate the Skip Blank Pages setting:

1. Right-click the  printer icon in the lower right corner of your screen 
(taskbar) and select Printer Settings.

Note: If you don’t see the icon, see display the printer icon for instructions on 
making it appear.

2. Click the Maintenance tab.

3. Click the Speed & Progress button, then click Skip Blank Page.

4. Click OK, then click OK again.

■ The printer won’t operate properly if it’s tilted or at an angle. Place it on a flat, 
stable surface that extends beyond the printer base in all directions.

■ You may need to uninstall your printer software and then reinstall it. See 
Uninstalling Printer Software.
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The margins are incorrect.

■ Make sure the paper you loaded matches the paper size and paper type settings 
you selected in your printer software. For instructions, see Printing in Windows 
or Printing with Macintosh OS X.

■ Choose the correct margins for your paper size.

■ If you’re using Mac OS X, make sure you choose the same printer in the Page 
Setup window and the Print window.

■ Use the Print Preview option in your printer software to check your margins 
before you print.

■ Make sure the paper is positioned all the way to the right of the sheet feeder. Slide 
the left edge guide against the paper.

■ You may need to uninstall your printer software and then reinstall it. See 
Uninstalling Printer Software.

Output is not what you expect when printing borderless photos.

■ Make sure you are printing on papers that support borderless printing. See 
Choosing Paper for Borderless Photos for details.

■ Use the expansion setting to adjust how the image fits on the page. See Printing 
Borderless Photos.

■ Don’t choose a custom paper size setting when printing borderless photos.

Too many copies are printing.

Make sure that the Copies option in your printer or application software is not set for 
multiple copies.

You see incorrect characters.

■ Make sure the USB cable is securely connected and meets the system 
requirements. Then try printing again.

■ If you’re using Windows, make sure your printer is selected. For Macintosh OS X, 
make sure your printer is selected in the Page Setup and Print windows. 

■ If you’re using a switch box or USB hub with your printer, connect the printer 
directly to your computer instead.
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■ If you’re using Windows Me or 98SE, you may need to clear stalled print jobs 
from the Spool Manager. For instructions, see Using Epson Spool Manager in 
Windows 98SE or Me.

■ You may need to uninstall your printer software and then reinstall it. See 
Uninstalling Printer Software.

The image size or position is incorrect.

■ Make sure the paper size and layout options are set correctly. See Printing in 
Windows or Printing with Macintosh OS X for instructions.

■ Your images may not match the width/height proportions of the paper size or 
layout you’re using, and may be cropped to fit.

Uninstalling Printer Software

You may need to uninstall and then reinstall your printer driver and utilities. For 
example, this might be necessary when you upgrade your operating system. You don’t 
need to uninstall Epson Print CD, PhotoImpression, or your on-screen User’s Guide.

■ Windows

■ Macintosh OS X

Windows

Note: Do not turn off or disconnect the printer while you are uninstalling the 
software.

1. Turn off the printer and disconnect its USB cable.

2. Click Start or , and select Programs or All Programs.

3. Select Epson or Epson Printers, then select Epson Printer Software 
Uninstall.

With Windows Vista, click Continue, then go to step 4.

4. In the next window, select EPSON Stylus Photo R270 Series, and click OK. 
Then follow the on-screen instructions.

5. Restart your computer, then see the Start Here sheet to reinstall your software.



126

Macintosh OS X

1. Quit all running applications.

2. Insert the Epson printer software CD-ROM into your Macintosh.

3. Open the Epson CD-ROM desktop icon.

4. Double-click the English folder, then double-click the OSX folder.

Note: 

You may have to scroll down to see these folders.

5. Double-click the Installer icon.

Note: If the Authenticate dialog box appears, enter your password or phrase and 
click OK.

6. When the Installer window appears, select Uninstall from the pop-up menu in 
the upper left and click Uninstall.

7. Follow the on-screen instructions to uninstall the printer software.

Note: 

If the name of your printer remains in the Print Center or Printer Setup Utility, 
select it from Printer List and click Delete.

8. Restart your Macintosh, then see the Start Here sheet to reinstall your software.

Setting Up Network Printing

■ Windows Vista, XP, and 2000

■ Windows Me and 98SE

■ Macintosh OS X

Windows Vista, XP, and 2000

This section tells you how to set up the Epson Stylus Photo R270 so that other 
computers on the network can print to it.
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Note: 

This section is for small network users only. If you are on a large network and 
would like to share the printer, consult your network administrator.

To install software programs in Windows Vista and XP, it is necessary to log on 
with a Computer Administrator account. You cannot install software programs if 
you log on as a Limited account user. After you install Windows Vista XP 
Professional x64, or XP, the user account is set as a Computer Administrator 
account.

To install software programs in Windows 2000, it is necessary to log on as a user 
with administrative privileges (a user who belongs to the Administrators group).

When you use your printer as a shared printer on a network with the following 
combinations of computers, the client operating systems may not be able to 
communicate directly with the printer and some functions will not be available for 
the client.

The images that are provided in the following section pertain to Windows XP.

First, you need to set up the Epson Stylus Photo R270 as a shared printer on the 
computer that it is directly connected to. Then, you must install the printer on each 
computer that will access it through the network.

Setting Up a Shared Printer

Follow the steps below to configure your computer to share the printer with other 
computers on a network.

1. Do one of the following:

Windows Vista: Click , select Control Panel, select Hardware and Sounds, 
then select Printer.

Windows XP: Click Start, select Control Panel, then select Printers and Faxes 
(or Printers and Other Hardware and then Printers and Faxes).

Server Client

Windows XP/XP Professional x64 
Edition/Windows Vista

Windows Me/98SE/2000

Windows Me/98SE/2000 Windows XP/XP Professional x64 
Edition/Windows Vista
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Windows 2000: Click Start, point to Settings, then select Printers.

2. Right-click the icon for the Epson Stylus Photo R270, then click Sharing.

3. Do one of the following:

Windows Vista: Click the Change sharing options button and click Continue. 
Then click Share this printer.

Windows XP: Select Share this printer.

Windows 2000: Select Shared as.

4. Type a name for the shared printer.

Note: Do not use spaces or hyphens in the shared printer name.

Note: With Windows XP, you may need to run the Network Setup Wizard before 
you can set up printer sharing. Start the wizard and follow the on-screen 
instructions until you see the screen above.

5. If you want Windows Vista, XP or 2000 to automatically download printer 
drivers to computers that are running different versions of Windows, click 
Additional Drivers and select the environment and the operating systems for the 
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other computers. Click OK, then insert the printer software CD into the 
CD-ROM drive. Select the folder for Windows Me or 98. Click OK to install the 
additional drivers.

6. Click OK, or click Close if you installed additional drivers.

Accessing a Network Printer

Follow the steps below to print to the printer from other computers on a network.

Note: The printer must be set up as a shared resource on the computer to which 
it is directly connected before you can access it from another computer. For 
instructions, see Setting Up a Shared Printer.

1. Do one of the following:

Windows Vista: Click , select Control Panel, select Hardware and Sounds, 
then select Printer.

Windows XP: Click Start, select Control Panel, then select Printers and Faxes 
(or Printers and Other Hardware and then Printers and Faxes).

Windows Me, 98SE, and 2000: Click Start, point to Settings, then select 
Printers.

2. Do one of the following: 

Windows Vista: Click Add a printer, then select Add a network, wireless, or 
Bluetooth printer. Windows searches for the printer on the network and displays 
its name when found. Follow the on-screen instructions to access the network 
printer.

Windows XP or 2000: Double-click the Add Printer icon. The Add Printer 
Wizard opens.

3. Click Next. 
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4. Select Network printer, then click Next.

5. On the next screen, click Next.

6. Double-click the icon of the computer that is directly connected to the printer. 
Then, click the icon for the Epson Stylus Photo R270.

7. Click Next and follow the on-screen instructions.
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Note: Depending on the operating system and the configuration of the computer 
to which the printer is connected, the Add Printer Wizard may prompt you to 
install the printer driver from the printer software CD. In this case, click the Have 
Disk button and follow the on-screen instructions.

Windows Me and 98SE

This section tells you how to set up the Epson Stylus Photo R270 so that other 
computers on the network can print to it.

Note: This section is for small network users only. If you are on a large network 
and would like to share the printer, consult your network administrator.

When you use your printer as a shared printer on a network with the following 
combinations of computers, the client operating systems may not be able to 
communicate directly with the printer and some functions will not be available for 
the client.

First, you need to set up the Epson Stylus Photo R270 as a shared printer on the 
computer that it is directly connected to. Then, you must install the printer on each 
computer that will access it through the network.

Setting Up a Shared Printer

Follow the steps below to configure your computer for printer sharing and to share 
the printer with other computers on a network.

1. Click Start, point to Settings, then select Control Panel.

2. Double-click the Network icon.

3. Click the File and Print Sharing button.

Server Client

Windows Vista, XP/XP Professional x64 
Edition

Windows Me/98SE/2000

Windows Me/98SE/2000 Windows Vista, XP/XP Professional x64 
Edition
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4. Select the I want to be able to allow others to print to my printer(s) check 
box and click OK.

5. In the Network dialog box, click OK.

Note: If a dialog box requesting the insertion of the Windows Me or 98 CD-ROM 
appears, insert the CD into the CD-ROM drive and follow the on-screen 
instructions.

If a dialog box requesting that you restart your computer appears, do so. Then 
continue with step 6.

6. In the Control Panel, double-click the Printers icon.

7. Right-click the icon for the Epson Stylus Photo R270 then click Share As.

8. Type a name for the shared printer, then click OK.
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Accessing a Networked Printer

Follow the steps below to print to the printer from other computers on a network.

Note: The printer must be set up as a shared resource on the computer to which 
it is directly connected before you can access it from another computer. For 
instructions, see Setting Up a Shared Printer.

1. Click Start, point to Settings, then select Printers.

2. Double-click the Add Printer icon. The Add Printer Wizard opens.

3. Click Next.

4. Select Network printer, then click Next.

5. On the next screen, click Browse.
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6. Double-click the icon of the computer that the printer is directly connected to. 
Then, click the icon for the Epson Stylus Photo R270.

7. Click OK and follow the on-screen instructions.

Note: Ink levels cannot be viewed from a workstation or client. 

Macintosh OS X 

To share the printer with other computers on a network, follow the steps below to 
configure the computer that it is directly connected to.

Setting Up a Shared Printer

To share the printer with other Mac OS X computers on a network, follow the steps 
below to configure the computer that it is directly connected to.

1. Turn on the printer.
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2. Select System Preferences from the dock, and click the Sharing icon. 

3. Click the check box next to Printer Sharing and close System Preferences. 

Accessing a Networked Printer

Follow the steps in this section to access the printer from other Macintosh OS X 
computers on the network.

1. Turn on the shared printer.

2. Print as you normally would, choosing the printer from the Shared Printers list 
that appears in the Page Setup and Print menus.

Where to Get Help

Epson provides these technical support services: 
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Internet Support

Visit Epson’s support website for solutions to common problems. You can download 
drivers and documentation, get FAQs and troubleshooting advice, or e-mail Epson 
with your questions.

Speak to a Support Representative

Before you call for support, please have the following information ready:

■ Product name (Epson Stylus Photo R270)

■ Product serial number (located on the back of the printer)

■ Proof of purchase (such as a store receipt) and date of purchase

■ Computer configuration and operating system version

■ Description of the problem

Then call:

Note: If your country does not appear on the list, contact the nearest Epson sales 
office.

Toll or long distance charges may apply.

Country Telephone number

Argentina (54 11) 4346-0300

Brazil (55 11) 4196-6350

Chile (56 2) 230-9500

Colombia (57 1) 523-5000

Costa Rica (50 6) 210-9555
(1 800) 377-6627

Mexico
Mexico City
Other cities

(52 55) 1323-2052
1- 800-087-1080

Peru (51 1) 418-0210

Venezuela (58 212) 240-1111

www.epson.latin.com
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Purchase Supplies and Accessories

You can purchase genuine Epson ink and paper from an authorized Epson reseller. To 
find the nearest reseller, please call your nearest Epson sales office.



138

Specifications

System Requirements

■ Windows System Requirements

■ Macintosh System Requirements

Windows System Requirements

To use your printer and its software, your system should have: 

■ A Microsoft® Windows compatible PC with a Pentium® processor (800 MHz or 
faster recommended)

■ Microsoft Windows 98SE, Windows 2000, Windows Me, Windows XP, 
Windows XP Professional x64 Edition, or Windows Vista 

■ 256MB RAM for Windows 98SE, Windows 2000, Windows Me, Windows XP, 
or Windows XP Professional x64 Edition (512MB recommended)

512MB RAM for Window Vista (1GB recommended)

■ 300MB free hard disk space (550MB or more recommended)

■ 4x or faster CD-ROM or DVD drive for installing the printer software

■ A Windows-compliant USB port and shielded USB “AB” cable up to 6.5 feet (2 
meters) long. Using an improperly shielded USB cable may cause the printer to 
malfunction. 

Macintosh System Requirements

To use your printer and its software, your system should have: 

■ An Apple Macintosh PowerPC® or Intel® Core™ processor.

■ Macintosh OS X 10.2.8, or 10.3.9 to 10.4.x

■ 256MB RAM (512MB recommended)

■ 300MB free hard disk space (550MB recommended)

■ 4x or faster CD-ROM or DVD drive for installing the printer software
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■ A USB port and a shielded USB “AB” cable up to 6.5 feet (2 meters) long. Using 
an improperly shielded USB cable may cause the printer to malfunction.

Technical Specifications

■ Printing

■ Paper

■ Printable Area

■ Mechanical

■ Ink Cartridges

■ Electrical

■ Environmental

■ Standards and Approvals

■ USB Interface

Printing

Paper

Note: Since the quality of any particular brand or type of paper may be changed 
by the manufacturer at any time, Epson cannot guarantee the quality of any 
non-Epson brand or type of paper. Always test a sample of paper stock before 
purchasing large quantities or printing large jobs.

Printing method On-demand ink jet

Nozzle configuration Black: 90 nozzles

Color: 450 nozzles (90 each cartridge: cyan, magenta, 
yellow, light cyan, light magenta)

Print direction Bidirectional with logic seeking
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Single sheets

Envelopes

Size A4 (210 × 297 mm [8.3 × 11.7 in.])

A6 (104 × 149 mm [4.1 × 5.8 in.])

Letter (8.5 × 11 in. [216 × 279 mm])

Legal (8.5 × 14 in. [216 × 356 mm])

Half-letter (5.5 × 8.5 in. [140 × 216 mm])

4 × 6 in. (102 × 152 mm)

5 × 7 in. (127 × 178 mm)

3.5 × 5 in. (89 × 127 mm)

8 × 10 in. (203 × 254 mm)

User Defined up to 216 mm × 1.12 m (8.5 × 44 in.)

Paper type Plain bond paper or special paper distributed by Epson

Thickness 0.08 to 0.11 mm (0.003 to 0.004 in.)

Weight (for plain bond 
paper)

64 g/m² to 90 g/m² (17 lb to 24 lb)

Size No. 10 (4.1 × 9.5 in.; 105 × 241 mm)

DL (4.3 × 8.7 in.; 109 × 221 mm)

C6 (4.5 × 6.4 in.; 114 × 163 mm) 

Paper type Plain bond paper

Weight 75 g/m² to 90 g/m²) (20 lb to 24 lb)
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Special Papers

Paper names Ultra Premium Photo Paper Glossy
Ultra Premium Glossy Photo Paper

Premium Photo Paper Semi-Gloss
Premium Semi-Gloss Photo Paper

Photo Paper Glossy
Glossy Photo Paper

Size 4 × 6 in. (102 × 152 mm)

Letter (8.5 × 11 in. [216 × 279 mm])

Paper type Special paper distributed by Epson

Paper names Premium Photo Paper Glossy
Premium Glossy Photo Paper

Size 4 × 6 in. (102 × 152 mm)

5 × 7 in. (127 × 178 mm)

8 × 10 in. (203 × 254 mm)

Letter (8.5 × 11 in. [216 × 279 mm])

Paper type Special paper distributed by Epson

Paper names Premium Bright White Paper

Premium Presentation Paper Matte Double-Sided
Epson Double-Sided Matte Paper

Presentation Paper Matte
Photo Quality Ink Jet Paper

Iron-on Cool Peel Transfer paper

Ultra Premium Photo Paper Luster
Premium Luster Photo Paper

Size Letter (8.5 × 11 in. [216 × 279 mm])

Paper type Special paper distributed by Epson
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Note: Poor quality paper may reduce the print quality and cause paper jams or 
other problems. If you have print quality problems, switch to a higher grade 
paper.

Do not load curled or folded paper.

Use paper only under these conditions:
Temperature: 15 to 25 °C (59 to 77 °F)
Humidity: 40 to 60% RH

Printable Area

Single sheets

Paper names Premium Presentation Paper Matte

Matte Paper Heavyweight

Size 8 × 10 in. (203 × 254 mm)

Letter (8.5 × 11 in. [216 × 279 mm])

Paper type Special paper distributed by Epson

Paper name Photo Quality Self Adhesive Sheets

Size A4 (210 × 297 mm [8.3 × 11.7 in.])

Paper type Special paper distributed by Epson

A

C

B-L B-R

Normal Borderless*
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Envelopes

Note: Always load paper into the sheet feeder with the short edge first. Load 
envelopes flap edge left with the flap side down.

A: The minimum top margin is 3.0 mm (0.12 inches).

B-L: The minimum left margin is 3.0 mm (0.12 inches).

The minimum left margin is 5.0 mm (0.20 inches) for envelopes.

B-R: The minimum right margin is 3.0 mm (0.12 inches).

The minimum right margin is 5.0 mm (0.20 inches) for envelopes.

C: The minimum bottom margin is 3.0 mm (0.12 inches) for single sheets and 
index cards.

D The minimum bottom margin is 20 mm (0.78 inches) for envelopes.

* When printing with the borderless feature, print quality may decline in the 
expanded area. Before printing large jobs using the borderless setting, print a 
single sheet to confirm printout quality.
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CDs or DVDs

If you print in the following areas of the disc, the disc or CD/DVD tray may get 
stained with ink:

Inner hub area 18 to 42 mm

Outer periphery area 117 to 120 mm for a 12-cm CD/DVD

77 to 80 mm for a 8-cm CD/DVD

120 mm

18 mm

80 mm

18 mm

12-cm CD/DVD 8-cm CD/DVD
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Mechanical

Ink Cartridges

Black Ink Cartridge

* Ink thaws and is usable after approximately 3 hours at 25 °C (77 °F).

Paper feed method Friction

Paper path Sheet feeder, top entry

Sheet feeder capacity About 120 sheets at 90 g/m² (24 lb)

Dimensions Storage

Width: 453 mm (17.8 inches)

Depth: 343 mm (13.5 inches)

Height: 194 mm (7.6 inches) 

Printing

Width: 453 mm (17.8 inches)

Depth: 538 mm (21.2 inches)

Height: 285 mm (11.2 inches)

Weight 6.5 kg (14.3 lb)

Color Black (81 or T0811, 82 or T0821)

Cartridge life 6 months at 25 °C (77 °F) after opening the package

Temperature Storage: 

–20 to 40 °C (–4 to 104 °F)

1 month at 40 °C (104 °F)

Freezing*: –16 °C (3.2 °F)

Dimensions Width: 12.7 mm (0.5 inches)

Depth: 68.0 mm (2.7 inches)

Height: 47.0 mm (1.9 inches)
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Color Ink Cartridges

* Ink thaws and is usable after approximately 3 hours at 25 °C (77 °F).

Caution: To ensure good results, use genuine Epson ink cartridges and do not 
refill them. Other products may cause damage to your printer not covered by 
Epson’s warranty.

Do not use an ink cartridge if the date on the package has expired.

Note: The ink cartridges packaged with your printer are partly used during initial 
setup. In order to produce high quality printouts, the print head in your printer will 
be fully charged with ink. This one-time process consumes a quantity of ink and 
subsequent cartridge sets will last for their full rated life.

Color Cyan (81 or T0812, 82 or T0782)

Magenta (81 or T0813, 82 or T0823)

Yellow (81 or T0814, 82 or T0824)

Light Cyan (81 or T0815, 82 or T0825)

Light Magenta (81 or T0816, 82 or T0286)

Cartridge life 6 months at 25 °C (77 °F) after opening the package

Temperature Storage: 

–20 to 40 °C (–4 to 104 °F)

1 month at 40 °C (104 °F)

Freezing*: –16 °C (3.2 °F)

Dimensions Width: 12.7 mm (0.5 inches)

Depth: 73.5 mm (2.9 inches)

Height: 55.3 mm (2.2 inches)
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Electrical

Note: Check the label on the back of the printer for the voltage information.

Rated voltage 100-120 V Model 220-240 V Model

Input voltage range AC 90 to 132 V AC 198 to 264 V

Rated frequency range 50 to 60 Hz

Input frequency range 49.5 to 60.5 Hz

Rated current 0.6 A (Max 0.9 A) 0.3 A (Max 0.5 A)

Power 
consumption

ISO/IEC10561 
Letter Pattern

Approx. 12 W

Sleep mode Approx. 1.1 W Approx. 1.2 W

Power off mode Approx. 0.2 W Approx. 0.4 W
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Environmental

Standards and Approvals

USB Interface

Temperature Operation: 10 to 35 °C (50 to 95 °F)

Storage: –20 to 40 °C (–4 to 104 °F)

1 month at 40 °C (104 °F)

Humidity Operation: 20 to 80% RH (without condensation)

Storage: 5 to 85% RH (without condensation)

Safety UL 60950-1

CAN/CSA-22.2 No.60950-1

EMC FCC part 15 Subpart B class B

CAN/CSA-CEI/IEC CISPR 22 Class B

USB 2.0 Hi-Speed (Device Class for computers)

USB 2.0 Hi-Speed (Mass Storage Class for external storage devices)
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Appendix

■ Safety Instructions

■ Copyright Notice

■ Responsible Use of Copyrighted Materials

■ Trademarks

Safety Instructions

Important Safety Instructions

Read all of the instructions in this section before using the printer. Also, be sure to 
follow all warnings and instructions marked on the printer.

Setting up the printer

Observe the following when setting up the printer:

■ Do not block or cover the vents and openings in the printer.

■ Use only the type of power source indicated on the printer’s label.

■ Use only the power cord that comes with the printer. Use of another cord may 
result in fire or electric shock.

■ The printer’s power cord is for use with the printer only. Use with other 
equipment may result in fire or electric shock.

■ Be sure your AC power cord meets the relevant local safety standard.

■ Avoid using outlets on the same circuit as photocopiers or air control systems that 
regularly switch on and off.

■ Avoid electrical outlets controlled by wall switches or automatic timers.

■ Keep the entire computer system away from potential sources of electromagnetic 
interference, such as loudspeakers or the base units of cordless telephones.

■ Do not use a damaged or frayed power cord.
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■ If you use an extension cord with the printer, make sure that the total ampere 
rating of the devices plugged into the extension cord does not exceed the cord’s 
ampere rating. Also, make sure that the total ampere rating of all devices plugged 
into the wall outlet does not exceed the wall outlet’s ampere rating.

■ Do not attempt to service the printer yourself.

■ Unplug the printer and refer servicing to qualified service personnel under the 
following conditions:

The power cord or plug is damaged; liquid has entered the printer; the printer has 
been dropped or the casing damaged; the printer does not operate normally or 
exhibits a distinct change in performance.

■ When connecting the printer to a computer or other device with a cable, ensure 
the correct orientation of the connectors. Each connector has only one correct 
orientation. Inserting a connector in the wrong orientation may damage both 
devices connected by the cable.

Choosing a place for the printer

Observe the following when choosing a place for the printer:

■ Place the printer on a flat, stable surface that extends beyond the base of the 
printer in all directions. If you place the printer by the wall, leave more than 10 
cm (3.9 inches) between the back of the printer and the wall. The printer will not 
operate properly if it is tilted at an angle.

■ When storing or transporting the printer, do not tilt it, stand it on its side, or turn 
it upside down. Otherwise, ink may leak from the cartridges.

■ Leave enough space in front of the printer for the paper to be fully ejected.

■ Avoid places subject to rapid changes in temperature and humidity. Also, keep the 
printer away from direct sunlight, strong light, or heat sources.

■ Avoid places subject to dust, shocks, or vibrations.

■ Leave enough room around the printer to allow for sufficient ventilation.

■ Place the printer near a wall outlet where the plug can be easily unplugged.
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Using the printer

Observe the following when using the printer:

■ Do not insert objects through the slots in the printer.

■ Take care not to spill liquid on the printer.

■ Do not put your hand inside the printer or touch the ink cartridges during 
printing.

■ Do not use aerosol products that contain flammable gases inside or around this 
product. Doing so may cause fire.

■ Do not move the print head by hand; otherwise, you may damage the printer.

■ Always turn the printer off using the power button. When this button is 
pressed, the green power light flashes. Do not unplug the printer or turn off 
the power to the outlet until the green power light stops flashing.

■ Before transporting the printer, make sure that the print head is in the home (far 
right) position and the ink cartridges are in place.

■ Leave the ink cartridges installed. Removing the cartridges can dehydrate the print 
head and may prevent the printer from printing.

■ Turn off and unplug the printer before cleaning. Clean with a damp cloth only.

Handling ink cartridges

Observe the following when handling the ink cartridges:

■ Keep ink cartridges out of the reach of children. Do not allow children to drink 
from or handle the cartridges.

■ Do not shake ink cartridges after opening their packages; this can cause leakage.

■ Be careful when you handle used ink cartridges, as there may be some ink 
remaining around the ink supply port. If ink gets on your skin, wash the area 
thoroughly with soap and water. If ink gets into your eyes, flush them 
immediately with water. If discomfort or vision problems remain after a thorough 
flushing, see a doctor immediately.

■ Do not remove or tear the label on the cartridge; this can cause leakage.
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■ Install the ink cartridge immediately after you remove it from its package. Leaving 
the cartridge unpacked for a long time before use can result in reduced print 
quality.

■ Do not use an ink cartridge beyond the date printed on the package. For best 
results, use up the ink cartridges within six months of first installing them.

■ Do not dismantle ink cartridges or try to refill them. This could damage the print 
head.

■ After bringing an ink cartridge inside from a cold storage site, allow it to warm up 
at room temperature for at least three hours before using it.

■ Store ink cartridges in a cool, dark place.

■ Do not touch the green IC chip on the side of the cartridge. Doing so may 
prevent normal operation and printing.

■ The IC chip on this ink cartridge retains a variety of cartridge related-information 
such as the ink cartridge status, so that the cartridge may be removed and 
reinserted freely. However, each time the cartridge is inserted, some ink is 
consumed because the printer automatically performs a reliability check.

■ If you remove an ink cartridge for later use, protect the ink supply area from dirt 
and dust, and store it in the same environment as the printer. A valve in the ink 
supply port makes covers or plugs unnecessary, but the ink may stain items that 
come into contact with this area of the cartridge. Do not touch the ink supply 
port or the surrounding area.

■ Store ink cartridges with their labels facing upward. Do not store cartridges upside 
down.

Copyright Notice

All rights reserved. No part of this publication may be reproduced, stored in a retrieval 
system, or transmitted in any form or by any means, electronic, mechanical, 
photocopying, recording, or otherwise, without the prior written permission of Seiko 
Epson Corporation. The information contained herein is designed only for use with 
this Epson printer. Epson is not responsible for any use of this information as applied 
to other printers.
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Neither Seiko Epson Corporation nor its affiliates shall be liable to the purchaser of 
this product or third parties for damages, losses, costs, or expenses incurred by 
purchaser or third parties as a result of: accident, misuse, or abuse of this product or 
unauthorized modifications, repairs, or alterations to this product, or (excluding the 
U.S.) failure to strictly comply with Seiko Epson Corporation’s operating and 
maintenance instructions.

Seiko Epson Corporation shall not be liable for any damages or problems arising from 
the use of any options or any consumable products other than those designated as 
Original Epson Products or Epson Approved Products by Seiko Epson Corporation.

Responsible Use of Copyrighted Materials

Epson encourages each user to be responsible and respectful of the copyright laws 
when using any Epson product. While some countries’ laws permit limited copying or 
reuse of copyrighted material in certain circumstances, those circumstances may not 
be as broad as some people assume. Contact your legal advisor for any questions 
regarding copyright law.

Trademarks

Epson, Epson Stylus, and MicroPiezo are registered trademarks; Epson Web-To-Page 
is a trademark of Seiko Epson Corporation.

RPM and BorderFree are registered trademarks; PhotoEnhance is a trademark; and 
Epson CreativeZone and Epson PhotoCenter are service marks of Epson America, 
Inc. 

General Notice: Other product names used herein are for identification purposes only 
and may be trademarks of their respective owners. Epson disclaims any and all rights 
in those marks.

© 2006 by Epson America, Inc. 
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